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1 Installing
What’s in this chapter
» Before Starting
» Connecting the HP Media Vault
» Powering on
» Checking the HP Media Vault Status
» Updating Your Firewall’s Trusted Program List
» Installing the Software
» Installing the Software on Additional Network Computers
» Installing Two or More HP Media Vaults
» Getting to Know the HP Media Vault
» Shutting Down and Restarting

The HP Media Vault stores and protects your digital content such as photos, 
music, videos, and documents. The Media Vault connects to your Local Area 
Network (LAN) so that this information can be shared by everyone on your 
network.

This chapter walks you through connecting the Media Vault to your network 
and powering it on. Once the Media Vault is connected, install the software 
on each network computer so it can access information on the Media Vault.

Before Starting
Important information about locating and using the HP Media Vault.
• HP Media Vault Location
• Network Requirements
• Supported Operating Systems
• Wireless Support
• Additional Software
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HP Media Vault Location
Find a suitable place to locate the HP Media Vault before installing the 
software on your computers. The location you choose must have either an 
available wired network connection to your broadband router or a switch 
connected to your broadband router.

The Media Vault also requires adequate ventilation to ensure it does not get 
too hot:
• Do not locate the Media Vault in an unventilated space.
• Make sure that the Media Vault’s front and back panels are not blocked.
• Check that the location of the Media Vault is not too hot. Maximum 

environmental temperature for operating the Media Vault is 40° C 
(104° F).

Network Requirements
To successfully use the HP Media Vault, your network should meet the 
following requirements:

Table 1: Network Requirements

Requirement Recommended

Media Vault connection 10 Mbps to 1000 Mbps (Gigabit Ethernet) 
wired connection

Network computers One or more computers running a 
supported operating system with a wired or 
wireless network connection. For a list of 
supported operating systems, see 
Supported Operating Systems on 
page 1-3.

Internet connection Broadband connection, such as DSL or 
cable, required for remote access 
functionality.
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Supported Operating Systems
The following operating systems are supported to work with the HP Media 
Vault.

Router An external Internet broadband router with 
10 Mbps (or faster) Ethernet connection to 
the Media Vault for remote access 
functionality and wired or wireless 
connections to the computers on the 
network.
Additionally, your router must have 
Dynamic Host Configuration Protocol 
(DHCP) enabled to provide an automatic 
IP address to the Media Vault.

Table 1: Network Requirements

Requirement Recommended
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File Backup

File Sharing

The HP Media Vault supports all of the above operating systems for file 
sharing. Additionally, the Media Vault can share files to Mac OSX and Linux 
computers.

Wireless Support
You must connect the HP Media Vault to your router (or switch) with an 
Ethernet cable. The Media Vault does not support wireless connection to your 
router. However, computers connected wirelessly to a wireless access point or 
router are supported.

Additional Software
Internet Explorer 6.0 or later is required to run the HP Media Vault software. 
Download Internet Explorer from http://www.microsoft.com/downloads.

iTunes 7.1 or later is required for combining household music libraries and 
streaming music with iTunes. Download iTunes from http://www.apple.com/
itunes/download.

Table 2: Supported operating systems

Windows Vista Windows XP

Windows Vista Home Basic Windows XP Home with Service Pack 2 
(SP2)

Windows Vista Home N (European Union 
only)

Windows XP Professional with SP2

Windows Vista Home Premium Windows XP Media Center Edition 2005 
with SP2 and Rollup 2

Windows Vista Business Windows XP Media Center Edition 2005 
with SP2

Windows Vista Business N (European 
Union only)

Windows XP Media Center Edition 2004 
with SP2

Windows Vista Enterprise Windows XP Tablet Edition with SP2

Windows Vista Ultimate
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Connecting the HP Media Vault
How you connect the HP Media Vault to your network depends on the 
network configuration. 

Figure 1: Connecting the HP Media Vault to the network

This example shows a broadband router (1) connecting the following:
• HP Media Vault (2)
• Desktop PC (3)
• Notebook computer with a wireless adapter (4)
• Broadband Modem (5)

The Media Vault uses a Dynamic Host Configuration Protocol (DHCP)-
enabled router to get its IP address. By default, most routers include a DHCP 
server. For more information, check your router documentation.

Caution: If you have wireless functionality on your network, be sure to 
enable your router’s security settings, such as Wi-Fi Protected Access (WPA) 
or Wired Equivalent Privacy (WEP), to protect your network. See the 
documentation that came with your router.

Powering on
Once the HP Media Vault is connected to the network, you are ready to 
power it on.
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Figure 2: Powering on the HP Media Vault

To power on the HP Media Vault

1 Plug one end of the power cable into the AC adaptor and the other end 
into an electrical outlet.

2 Plug the AC adaptor into the HP Media Vault.
3 Connect one end of the Ethernet cable to the Media Vault and the other 

end to an available Ethernet port on your router.
4 Press the Power button on the back of the Media Vault.

The indicator lights blink throughout the startup process. Once the Media 
Vault is initialized and ready, the lights are solid blue.

Checking the HP Media Vault Status
The lights on the front of the HP Media Vault give you information about the 
status and health of your hard drives, power supply, network connection, and 
overall Media Vault health. In addition to the Media Vault indicator lights, the 
system tray and alert log provide information about the health of the system. 
For additional information, see Viewing the Alert Log on page 2-23.
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After the HP Media Vault startup completes and prior to the first software 
installation, the indicator lights show:
• Hard drive—off if you do not have a second drive, or solid purple 

 if you do have a second drive. After installing the software, 
add the second drive to storage as either mirrored or non-mirrored space. 
For additional information, see To add a hard drive to total storage on 
page 10-121.

• System drive—solid blue 
• Power—solid blue 
• Network—solid blue 
• Health—solid purple 

After you complete the software installation, all lights should be solid blue. 

If the lights are not solid blue, see Troubleshooting on page 12-153.

Updating Your Firewall’s Trusted Program List
The HP Media Vault Software Installation Disc installs several programs that 
enable your computer to communicate with the HP Media Vault over your 
network. Software firewalls installed on your computer can block this 
communication and prevent the computer from locating the HP Media Vault 
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on your network. The following steps are recommended before installing the 
HP Media Vault software:
• Launch your firewall and anti-virus software and update the trusted 

programs list.
• Verify that your firewall and anti-virus software are set to "Learn" new 

programs. After the HP Media Vault software is installed, the firewall 
should prompt you to allow the installed programs to communicate with 
the Media Vault.

• If you are using a firewall or anti-virus program that cannot automatically 
update its trusted software list, please contact the firewall or anti-virus 
software vendor to find out how to manually add software to the trusted 
software list. Then, visit http://www.hp.com/go/support for a list of 
software to add.

Installing the Software
Use the Software Installation Disc to install the HP Media Vault software on 
each computer on your network.

The software installation consists of the following:
• HP Update (if not already installed)
• Windows components—Windows Installer 3.1 and .NET 2.0 or later 

software. (Installed only if they are not already on the computer)
• HP Media Vault software

Checking for Administrative Privileges
You must have administrative privileges on your home computer to install the 
software. Complete the following instructions for Windows Vista or Windows 
XP to view or change user account settings.

Sidebar: Hubs and Network Health Light

Some network hubs, as opposed to switches or routers, may reduce performance 
between your computer and the HP Media Vault, or the hub may prevent your computer 
from communicating with the Media Vault. If this is a problem, the network health 
indicator light on the front of the server will be off. Replacing the hub with a switch may 
improve the network performance or restore connectivity.
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• In Windows Vista, click Start, Control Panel, and then User 
Accounts and Family Safety.

• In Windows XP, click Start, click Control Panel, and then double-click 
User Accounts.

Inserting the Software Installation Disc
The Software Installation Disc installs the HP Media Vault software and 
necessary components on your computer.

1 Insert the Software Installation Disc into a computer connected to your 
network. The installation starts.

2 Follow the instructions on each installation page. The remainder of this 
chapter describes important parts of the installation; not every step is 
described.

Note: Computers running Windows Vista may display User Account Control 
messages, such as “A program needs your permission to Continue.” Click 
Continue.

Welcome to the HP Media Vault Installation Program
The first installation page is the Welcome dialog. Click Next to display and 
accept the end user license agreement. Click Next to proceed to the Ready 
to install HP Media Vault dialog.



Version 1-10

Figure 3: HP Media Vault Setup Welcome dialog

Note: If autorun is disabled in Windows XP, start the installation by 
selecting the Windows Start menu and clicking Run. Type <drive 
letter>:\setup.exe and click OK. For example, type d:\setup.exe. In 
Windows Vista and Windows XP, you can display the Run dialog by 
pressing Windows Key + R on most keyboards.

Starting the Installation
Click Install on the Ready to install HP Media Vault dialog.
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Figure 4: Ready to Install HP Media Vault dialog

Installing the Software Components
The following components are installed. Some of the Windows components 
may already be installed on your computer. If they are already installed, they 
will not be installed again. This installation may restart your computer and 
take several minutes.
• Microsoft .Net Framework 2.0
• HP Update
• NTI DriveBackup! (Available on the HP Media Vault Pro only)
• NTI Shadow
• HP Media Vault software
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Figure 5: Installing the HP Media Vault Software Components

The HP Media Vault software automatically installs after the components.

Configuring the HP Media Vault
Click Yes to configure the Media Vault’s language, date, time, time zone, 
and network workgroup based on your computer settings.
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Note: If you have two disks in your Media Vault the light for the second disk 
is solid purple . After installing the software, add the second drive 
to storage as either mirrored or non-mirrored space. 

For additional information, see To add a hard drive to total storage on 
page 10-121.

Getting Started
After the installation completes, click View Getting Started for assistance in 
setting up your HP Media Vault and to get an overview of some of the key 
features.

Installing the Software on Additional Network 
Computers

If you want to access information on the Media Vault from a computer or 
include a computer in backups to the Media Vault, the HP Media Vault 
software must be installed on that computer.

After completing the setup, use the Software Installation Disc to install the HP 
Media Vault software on the other computers on the network. Install the 
software on one computer at time.
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Installing Two or More HP Media Vaults
If you add additional HP Media Vaults to your network, run the software 
installation disk on one network computer for each Media Vault that you 
added. You do not need to complete multiple installations of the software on 
all of the network computers, just one.

If you have more than one Media Vault, the second is called HPMediaVault1, 
the third is called HPMediaVault2, and so on.

Getting to Know the HP Media Vault
The HP Media Vault has lots of features that enable you to manage and share 
your documents, music, photos, and videos.

Starting the HP Media Vault Software
Double-click the HP Media Vault desktop shortcut  to open the HP Media 
Vault Control Center. Alternatively, click Start, All Programs, HP Media 
Vault, and then Control Center to open the Control Center from the Start 
menu in Windows XP or Vista.

The Control Center has several tabs. Each tab and the features on it are 
discussed below.
• Main Tab on page 1-14
• Backup Tab on page 1-15
• Tools Tab on page 1-16
• Help & Support Tab on page 1-17

Main Tab
The main tab has buttons for browsing folders on the HP Media Vault and for 
opening the HP Photo Webshare.
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Figure 6: Main tab of the HP Media Vault Control Center

• HP Media Vault—Browse the shared folders on your HP Media Vault.
• Documents—Browse the Documents shared folder on your HP Media 

Vault.
• Photos—Browse the Photos shared folder on your HP Media Vault.
• Photo Webshare—Open the Photo Webshare on your HP Media 

Vault.
• Music—Browse the Music shared folder on your HP Media Vault.
• Videos—Browse the Videos shared folder on your HP Media Vault.

Related Information

Photo Webshare on page 3-33

Backup Tab
Protect your documents, photos, music, and videos by backing them up 
regularly.
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Figure 7: Backup tab of the HP Media Vault Control Center

• Back up Important Files—Opens an application to start an 
immediate backup or schedule regular backups of specific files or folders 
on the network computer that you are currently using. Backed up files are 
stored on the HP Media Vault.

• Back up Entire Hard Drive—Opens an application to back up the 
hard drive of the computer you are currently using. This feature is only 
available on the HP Media Vault Pro.

• Back up HP Media Vault—Opens the HP Media Vault 
Administration Console. The Backup tab has features for backing up files 
on the Media Vault to an external USB device.

• Online Backup—Links to a web site for purchasing an online service 
for backing up computer files and folders.

Related Information

Back up and Restore on page 11-137

Tools Tab
The Tools tab contains features for managing and configuring your HP Media 
Vault.
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Figure 8: Tools tab of the HP Media Vault Control Center

• Customize HP Media Vault—Manage and configure your HP Media 
Vault’s system settings.

• Map Drive Letter—Start an application that maps drive letters on your 
computer to shared folders on your HP Media Vault.

• Settings for iTunes—Set up this computer to automatically copy your 
iTunes music library to the HP Media Vault for sharing.

• HP Update—Check for any HP software updates.

Help & Support Tab
Documentation for the HP Media Vault is available in a variety of formats and 
locations. This section tells you where you can get help for using the HP 
Media Vault.
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Figure 9: Help & Support tab of the HP Media Vault Control Center

• User’s Guide—Contains helpful information for setting up and using 
the HP Media Vault.

• Online Support—Additional support and informational articles are 
available at http://www.hp.com/support.

• Need Accessories?—Open a browser to the HP online store.

In addition to features on the Help & Support tab, help buttons provide 
additional information for the page or dialog they are on.

Additionally, question marks  appear next to some fields on the Media 
Vault configuration pages. Click the question marks to get detailed 
information on specific fields.

Information associated with help buttons and questions marks can also be 
found in the User’s Guide.

Shutting Down and Restarting
Follow these instructions to turn off or restart your Media Vault.

To turn off the HP Media Vault

Momentarily press the power button on the back of the HP Media Vault to 
turn it off or complete the following steps.
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1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 On the System tab, click Shutdown.

To restart the HP Media Vault

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 On the System tab, click Restart.
Restarting the Media Vault turns it off and on—as if you unplugged and 
plugged it back in. None of your current settings or files are lost.
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2  Configuring System Settings
What’s in this chapter
» Viewing System Information
» Viewing the Alert Log
» Viewing System Settings
» Editing System Settings
» Changing the Date and Time
» Changing Firmware Update Options
» What do you want to do next?

You are ready to configure the HP Media Vault system settings after the 
software is installed on at least one computer. This chapter describes how to 
set up your system settings.

After configuring the system, you are ready to start using the Media Vault. 
Refer to the section of the User’s Guide for the functionality you want to use. 
Whether you want to consolidate files on the Media Vault, share photos and 
videos across the Internet using Webshare, integrate iTunes music libraries, or 
explore other Media Vault features, each section of User’s Guide describes 
how to set up and start using that feature.

Viewing System Information
The Status tab of the Administrative Console summarizes information about 
the health and configuration of the HP Media Vault.

To view system information

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.
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The following information displays on the Status tab of the Administrative 
Console.
• System Status

The system status shows whether there are alerts or not. Click View Log 
to see a list of HP Media Vault activities. The date and time, description, 
and importance level are associated with each activity.

• Serial Number
The serial number is also printed on a sticker on the HP Media Vault. You 
may be asked to provide the serial number if you call HP customer 
support.

• Firmware Version
Hewlett-Packard occasionally offers upgrades to the HP Media Vault 
firmware. The firmware version number identifies the installed firmware 
release.

• New Firmware Available
Click to download and install the latest HP Media Vault firmware. 
Installing updates ensures that you experience the full functionality and 
performance of the HP Media Vault.

• Date and Time
This field displays the Media Vault's current date and time. Files created 
on the Media Vault and all date and time stamped activities use this 
information.

• Remote Access
Remote access is either enabled or disabled. If it is disabled, enable it by 
clicking Setup and then Set Up Web Address to create a personal 
domain and set up remote access.

• Last Backup
Date of the last backup of the shared folders on the HP Media Vault to a 
USB device.

• Language
Select a language from the drop down list.

• Disk Usage
Total Storage
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Total Storage is the sum of the storage space on your HP Media 
Vault's disk drive 1 and disk drive 2, if you have one. It does not 
include storage space on any devices connected directly to the Media 
Vault or over the network, such as a USB drive or another computer.
Available Storage
Available Storage is the amount of free space on your HP Media 
Vault.

Related Information
• Changing the Date and Time on page 2-27
• Enabling Remote Access on page 9-99

Viewing the Alert Log
Alerts are listed at the top of the page and vary in their importance level. 
Mounting a new hard drive results in a relatively minor alert status, but a hard 
drive failure is given a critical alert.

A list of HP Media Vault activities are recorded in the Alert Log History. 
The date, time, and description are associated with each activity.

To view the alert log

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 Click View Log next to System Status to open the alert log.
Read the log. Click Acknowledge to clear the alert notification on 
the Media Vault home page and in the system tray on network 
computers.
Click Delete Log to clear the log.
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Viewing System Settings
The System tab displays configuration information for the HP Media Vault. The 
Media Vault administrator can edit these settings.

To view system settings

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 Click the System tab.

The following information can be viewed from the Systems Settings tab.
• System Name

You can change the name of the HP Media Vault. This is useful if you 
have more than one Media Vault on the same network. The default 
network name is HPMediaVault.
Keep in mind that renaming a Media Vault forces all your network 
computers to remap their shared network resources, such as mapped 
drives. It is best to only change the Media Vault name during the initial 
setup.
Do not include spaces in the name. Only 15 alphanumeric characters are 
allowed.

• Admin User Name
The HP Media Vault’s administrator user name. There is only one 
administrator for the Media Vault. 
The administrator user name and password are used to access and make 
changes to the HP Media Vault Administration console. The administrator 
does not have access to other HP Media Vault features. To create a user 
for remote access features such as Internet file browsing and HP Photo 
Webshare, see To create a user on page 4-55.

• Password
The HP Media Vault does not come pre-set with an administrator user 
name or password, which means that anyone on your network can work 
as an administrator. This simplifies getting started, but not having an 
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administrator user name and password also gives every network user 
access to the Media Vault's configuration screens. Furthermore, if remote 
access is enabled, anyone with your personal web address can open the 
configuration pages for your HP Media Vault.
To secure the configuration options on your Media Vault, assign a Media 
Vault administrator user name and password. Once they are set, they are 
required to log on to the Media Vault configuration pages.

• LED Brightness
Determines the brightness of the lights on your Media Vault. LED 
brightness can be On, Dim, or Off.

• Turn Off Hard Disks After
The HP Media Vault comes with a power-saving feature. After one-hour of 
inactivity, the Media Vault's internal hard disks spin down. When activity 
on your network again accesses the Media Vault’s hard drive, the hard 
disks automatically spin up.
Power-saving mode lowers power consumption, and your Media Vault’s 
internal hard drives experience less wear and tear.

• Date and Time
The Media Vault’s current date and time.

• Firmware Version
Hewlett-Packard occasionally offers upgrades to the HP Media Vault 
firmware. The firmware version number identifies the installed firmware 
release.

• New Firmware Available
Indicates if there is new firmware available.

• Reset Media Server
Stops the UPnP media server and the iTunes server, deletes their internal 
databases, then re-starts them.

• Shutdown
Turns the Media Vault off.

• Restart
Turns the Media Vault off and back on.
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Related Information

Viewing the Alert Log

Editing System Settings
System settings define preferences for your Media Vault. Information such as 
your Media Vault’s name, administrators user name and password, the date 
and time, and alerts for firmware updates are found here.

To edit system settings

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up.

3 On the System tab, click Edit.
4 Type the System Name.

You can change the name of the HP Media Vault. This is useful if you 
have more than one Media Vault on the same network. The default 
network name is HPMediaVault.
Keep in mind that renaming a Media Vault forces all your network 
computers to remap their shared network resources, such as mapped 
drives. It is best to only change the Media Vault name during the initial 
setup.
Do not include spaces in the name. Only 15 alphanumeric characters are 
allowed.

5 Type the Admin User Name.
The administrator user name and password are used to access and make 
changes to the HP Media Vault Administration console. The administrator 
does not have access to other HP Media Vault features. To create a user 
for remote access features such as Internet file browsing and HP Photo 
Webshare, see To create a user on page 4-55.

6 Type and confirm the administrator’s Password.
The HP Media Vault does not come pre-set with an administrator user 
name or password, which means that anyone on your network can work 
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as an administrator. This simplifies getting started, but not having an 
administrator user name and password also gives every network user 
access to the Media Vault's configuration screens. Furthermore, if remote 
access is enabled, anyone with your personal web address can open the 
configuration pages for your HP Media Vault.
To secure the configuration options on your Media Vault, assign a Media 
Vault administrator user name and password. Once they are set, they are 
required to log on to the Media Vault configuration pages.

7 Select the LED Brightness.
Select On for full brightness, Dim to reduce the brightness, or Off to turn 
the LEDs off completely. The power light remains on.

8 Select a time from the Turn Off Hard Disks After drop down list.
The HP Media Vault comes with a power-saving feature. After one-hour of 
inactivity, the Media Vault's internal hard disks spin down. When activity 
on your network again accesses the Media Vault’s hard drive, the hard 
disks automatically spin up.
Power-saving mode lowers power consumption, and your Media Vault’s 
internal hard drives experience less wear and tear.

9 Click Edit to change the Date and Time.
10 Click Firmware Options to change firmware settings or install 

updates.
Installing firmware updates ensures that you experience the full 
functionality and performance of the Media Vault.

11 Click Save.

Related Information
• Changing the Date and Time
• Changing Firmware Update Options

Changing the Date and Time
There are four options for setting the date and time on your Media Vault.

One option is to click Yes on the HP Media Vault Configuration dialog at the 
end of the installation to use your computer settings for the language, date, 
time, time zone, and network workgroup.
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The factory default method for maintaining the date and time after the initial 
installation is to synchronize the Media Vault with an Internet Network Time 
Protocol (NTP) server. This feature is called Set Clock from Internet time 
server and it periodically checks the date and time using the Internet.

If you do not want to set your clock using the Internet time server, you can 
type the date and time or click Set time from browser. Both of these 
options are a one-time change. Neither of them check the date and time on 
an ongoing basis to make sure they are accurate.

See the instructions below for changing the date and time after the software 
installation.

Figure 10: Default date and time settings

To set the clock from Internet time server

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 On the System tab, click Edit.
4 Click Edit next to Date and Time.
5 Select the Set Clock from internet time server check box.
6 Type the NTP server IP address or name in Time server 1.
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Type an optional NTP server IP address or name in Time server 2.
7 Select your Time Zone.
8 Check Automatically adjust daylight savings, if applicable.
9 Click Save.

To set the clock manually or from browser

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 On the System tab, click Edit.
4 Click Edit next to Date and Time.
5 Clear the Set Clock from internet time server check box.
6 Enter the Date and Time or click Set time from browser.
7 Select your Time Zone.
8 Check Automatically adjust daylight savings, if applicable.
9 Click Save.

Changing Firmware Update Options
You can choose between simple and advanced firmware settings.

When firmware updates are available, go to the simple settings page to 
install them directly from the Internet. Use the advanced firmware settings 
page to download updates to a network computer and install them to the 
Media Vault.

To change firmware update options

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 On the System tab, click Edit.



Version 2-30

4 Click Firmware Options.
The Simple Settings page displays.

5 If you want your Media Vault to automatically check for and install 
firmware updates, check Automatically check for new firmware.

6 Check Raise alert when new firmware is available to display a 
message box on your network computer when new firmware is 
downloaded and ready to install.

7 Select the frequency for checking for updates from the Check for new 
firmware every drop down list.

8 Click Save.

To install firmware updates immediately

There are two ways that the HP Media Vault notifies you of firmware updates. 
One is on the HP Media Vault tab of the Administration Console. If 
there is a Yes next to New Firmware Available, click Install. The 
Firmware Options Simple Settings page opens. Click Install Firmware to 
start the installation. The Media Vault automatically reboots when the install is 
complete.

The other way the Media Vault notifies you of a firmware updates is by an 
alert on your network computer. Click OK to close the alert. Open the 
Administration Console and follow the above steps to install the update 
immediately.

To save firmware updates to a computer and install

If your HP Media Vault does not have an Internet connection or if you want to 
control when firmware updates are installed, clear the Automatically 
check for new firmware check box. It is recommended that you 
periodically check for firmware updates on the HP support web site.

1 From a network computer, go to www.hp.com/support and download the 
firmware update.

2 Specify a location on the network computer for saving the file.
3 Once the file is downloaded, go to the HP Media Vault 

Administration Console as described in To change firmware 
update options above.

4 Click the System tab and then click Edit.
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5 Click Firmware Options and then click Advanced Settings.
6 Browse to the download location and click Install Firmware.

The update installs on the Media Vault. The Media Vault automatically 
reboots when the install is complete.

What do you want to do next?

Share Photos over the Web
See, Photo Webshare on page 3-33

Consolidate Media Files on the Media Vault
See, Organizing and Browsing Folders on page 6-71

Stream Media to your Entertainment Center
See, Streaming Media on page 8-93

Access Media Files Remotely
See, Remote Access on page 9-99

Configure Media Vault Backups
See, Back up and Restore on page 11-137

Secure your Media Vault
See, Securing Your Media Vault from Intruders on page 7-91
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3 Photo Webshare
What’s in this chapter
» Before You Begin
» Logging on to HP Photo Webshare
» Webshare Home Page
» Managing Webshare User Accounts
» Creating an Album to Share
» Notifying Visitors by Email
» Viewing and Saving Photos
» Changing a Visitor’s Password
» Frequently Asked Questions

Securely share your photos and video clips with friends and family directly 
from your HP Media Vault Server using HP Photo Webshare.
• Set up a secure, personal web address to be used for remote access and 

by visitors to your HP Photo Webshare.
• Set up groups for sharing the different photo albums, such as family, ski 

club, and soccer team.
• Give specific visitors permission to add their own photos for sharing.

Before You Begin
Some set up is required before logging on to the HP Photo Webshare for the 
first time. Check that the following configuration steps are complete.

Select at least one user account to be a Photo Webshare Manager
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Select at least one user account to be a Photo Webshare 
Manager

1 At the computer, double-click the HP Media Vault Monitor icon in the 
system tray.

2 Click the Tools Tab.
3 Click on Customize HP Media Vault to access the Control Center.
4 On the Users Tab click the Create User link in the upper right.
5  Enter a User Name and Password. Ensure the check box for Photo 

Webshare Manager is checked. 

Set up remote access

For information on setting up Remote Access see Remote Access on page 9-
99

Logging on to HP Photo Webshare
 
Note: Remote Access must be externally verified before logging into HP 
Photo Webshare

1 At the computer, click Start, All Programs, and then select HP 
Media Vault Server.
The HP Media Vault Server—Control Center opens.

2 On the Main tab, click Photo Webshare.
3 Type your User name and Password (Created during initial install 

and setup for the Media Vault Server) and click Logon.
You are connected to the HP Photo Webshare where you can create and 
share albums over the Web with friends and family.
User names are not case sensitive. However, passwords are case 
sensitive.
Note: You are automatically logged out of Photo Webshare if there is 
no activity after 30 minutes.
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Forgot Your Password?
Note: This is only used for Visitor account (accounts from outside the home 
network). Type your email address into the log on page and a message is 
sent to you with your user name and instructions for changing your password.

Webshare Home Page
The HP Photo Webshare home page displays icons for each of your photo 
albums. Albums can be sorted by Modification Date or Name. Click 
Create new album to create and share photos and videos with friends 
and family. The following features are available on this page.

To view the HP Photo Webshare home page

1 Log on to the HP Photo Webshare.

For more information, see Logging on to HP Photo Webshare on page 3-
34.

2 View the following album information on the Webshare home page.
My Webshare—click My Webshare in the upper left corner of 
the page to return to the Webshare home page at any time.
Visitors—opens the Manage Visitors page for adding, deleting, 
and editing visitors. This is also where you setup email notifications for 
server users.
Groups—opens the Manage Groups page for adding, deleting, 
and editing groups.
My Server—click My Server in the title bar to go to the HP Media 
Vault Server home page.
Help—opens the HP Media Vault Server User’s Guide.
Sort by:
– Modification date—sorts photo albums ascending or 

descending by the last date they were modified. When you open 
Webshare, albums are sorted descending by modification date so 
the most recently changed albums are at the top.

– Name—sorts albums alphabetically ascending or descending by 
album name.

Create new album—creates a new album.



Version 3-36

Album Picture or Name—hover over the album picture to display 
the album title, creation date, creator name, and description. Click the 
album picture or name to add more photos, save photos to your 
computer, or view photos in a slideshow. Click My Webshare in the 
title bar to return to the home page.
Manage—adds, deletes, rotates, and reorders photos. After making 
changes to the album, click Next to share and notify friends and 
family of the updates or Finish to return to the HP Photo Webshare 
home page. The Manage link displays for Webshare Managers and 
visitors that have permission to add photos to albums.
Delete—Webshare Managers can delete albums.
Shared Album—  albums with this icon are shared with one or 
more visitors. Visitors can view, add, or print photos depending on 
their permissions. Albums without this icon have not been shared and 
cannot be viewed by people other than the Webshare managers and 
the person that created the album.
Photos to approve—  albums with this icon have unapproved 
photos from visitors or server users. Once approved, the new photos or 
videos are available to view by everyone that has access to that 
album.

Managing Webshare User Accounts
Webshare user accounts are required for each person that you want to share 
your albums with. User accounts are also required for each person that you 
want to give permission for creating albums or for managing Webshare 
features.

This section includes the following topics
• About the Types of Webshare User Accounts
• Managing Visitors
• Managing Groups

About the Types of Webshare User Accounts
There are three types of Webshare user accounts: Visitors and Webshare 
Managers. Each one is described below.
• Visitors
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• User Accounts
• Webshare Managers

Visitors
HP Photo Webshare albums can be shared with people outside your local 
network, called visitors. If you use the HP Media Vault Server for personal 
use, visitors may be family or friends such as Grandma or Aunt Karen. If you 
use the Server for business, visitors may be your customers or business 
partners.

Visitors can have different levels of access to albums. At a basic level, visitors 
can view photos in the albums you choose to share with them. If you select to 
give visitors additional permissions, they can add photos to albums or save 
photos to their computers.

Visitors can be assigned to one or more groups. When you share albums, 
you select individual visitors or groups of visitors to notify that there is a new 
album available to view.

User Accounts
Server user accounts are different from visitors. Server users can also use HP 
Photo Webshare. For more information, see Creating a User on page 4-55.

Webshare Managers
Webshare Managers have access to all HP Photo Webshare features, 
including viewing and managing content in all albums, sharing albums with 
people outside the home network, and approving album content added by 
people that share the album. At least one Webshare Manager user account 
should be created before you can log on to the HP Photo Webshare. For 
more information, see Before You Begin on page 3-33.

Managing Visitors
Visitors are managed from within the HP Photo Webshare. This section 
provides steps for
• To view visitors
• To create or edit visitors
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To View Visitors
The Manage Visitors page lists all Webshare user accounts and summaries 
their permissions.

1 Log on to the HP Photo Webshare.
For more information, see Logging on to HP Photo Webshare on page 3-
34.

2 Click Visitors in the upper right corner of the HP Photo Webshare to 
view a list of visitors and the following information.
The Visitor link is visible for Webshare Managers only. Visitors do not see 
the Visitor link when they log on to Webshare.

User name—unique identifier for each visitor. User names can only 
be used once. Initially the user name is their users email address.

First name—the visitor’s first name.
Last name—the visitor’s surname.
Add photos—gives visitors the ability to add photos to an album. 
Visitors with add photos permission must logon to the Webshare with 
a user name and password. If the visitor also has auto-approve ability, 
there are no limitations on the size or quantity of files that the visitor 
can add.
If the visitor does not have auto-approve ability, a Webshare Manager 
must approve added photos and videos before other visitors can see 
them. Visitors without auto-approve ability have a limited amount of 
disk space that they can use for uploading photos and video before 
they are approved by a Webshare Manager.
Save photos—gives visitors the ability to select, size, and save 
photos from the HP Photo Webshare to their computer. For more 
information, see Saving Photos on page 3-51.
Auto-approve—automatically approves photos added to an album 
by this visitor. Use caution when giving visitors this permission. Auto-
approved photos and videos are immediately viewable by all visitors 
with access to that album.
For additional information, see Adding Photos to Your Album on 
page 3-44.
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Email—enables the visitor to be notified of new or changed albums. 
The visitor must have an email address to receive notifications. For 
additional information on notifications, see Sharing an album on 
page 3-47.

Note: In the footer of the email notification there is an option for visitors 
to unsubscribe if they do not want to receive future notifications. When 
visitors unsubscribe, the check mark is cleared from this option.

Delete—click the trash can to remove the visitor.
Note: Webshare Managers user accounts cannot be deleted from 
within HP Photo Webshare. 

Edit—click to change visitor information. All visitor information can be 
changed except for the user name.

If you need to change the user name, you must delete the visitor and 
create them again. Be sure to add the visitor back to the appropriate 
groups after they are re-created.

To Create or Edit Visitors
This page allows you to add a new visitor or change the information for an 
existing visitor.

1 Log on to the HP Photo Webshare.
For more information, see Logging on to HP Photo Webshare on page 3-
34.

2 Webshare Managers click Visitors in the upper right corner of the HP 
Photo Webshare.

3 Click Create Visitor or click Edit next to an existing visitor.
If adding a visitor, the first field is the email address. The email address 
becomes the user name when the visitor is saved. If editing a visitor, the 
first field shows the user name.

4 Type the Email Address for the new visitor. If you are editing an 
existing visitor, the email address is the User Name and it cannot be 
changed.
Use only the following characters when typing the Email Address:

Uppercase letters—A, B, C, and so on.
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Lowercase letters—a, b, c, and so on.
Numbers—0, 1, 2, 3, 4, 5, 6, 7, 8, 9
Symbols—use only: dash - underscore _ period . space [ ]

Note: After creating a visitor, the user name cannot be edited. If you 
need to change the User Name, you must delete the visitor and create 
a new one. Be sure to add the visitor back to the appropriate groups, as 
needed.

5 Type or change the remaining information for the visitor.
For detailed descriptions of each of the fields on this page, see To view 
visitors on page 3-38.
Note: Passwords for Webshare Managers cannot be managed from 
within Webshare. 

 For more information, see Creating a User on page 4-55.
6 Select visitor permissions.

Add Photos: These visitors can add photos
Check to give visitors the ability to add photos to an album. Visitors 
with the add photos permission must logon to the Photo Webshare 
with a user name and password. 
If the visitor does not have auto-approve ability, a Webshare Manager 
must approve added photos before other visitors can see them.

Note: Visitors with Add Photos checked must also have passwords.

Save Photos: These visitors can save photos
Check to give visitors the ability to select, size, and save photos from 
the HP Photo Webshare to their computer. For more information, see 
Saving Photos on page 3-51.

Note: Visitors with Save Photos checked must also have passwords.

Auto-approve: These visitors can add photos without 
your approval.
Check to automatically approve photos added to an album by this 
visitor. Use caution when giving visitors this permission. Auto-approved 
photos and videos are immediately viewable by all visitors with access 
to that album. Once logged on, there are no limitations on the size or 
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quantity of files that the visitor can add. For additional information, 
see Adding Photos to Your Album on page 3-44.
Email: These visitors can receive email notifications and 
can unsubscribe.
Check to enable the visitor to receive notifications of new or changed 
albums. The visitor must have an email address saved to their user 
account to receive notifications. For additional information on 
notifications, see Sharing an album on page 3-47.
In the footer of the email notification there is an option for visitors to 
unsubscribe if they do not want to receive notifications in the future. 
When visitors unsubscribe, the check mark is cleared from this option.

7 Albums to View—select the albums this group can view. Click Select 
All to select all albums. Clicking a second time, deselects the albums. 
You can also check individual albums to select them. For additional 
information, see Creating an Album to Share on page 3-43.

8 Select the Groups that this visitor is a member. 
For example, Friends, Family, Soccer Team. For more information, see 
Creating or editing groups on page 3-42.

Managing Groups
This section has steps for
• Viewing groups
• Creating or editing groups

Viewing Groups
When you are ready to share albums, the HP Photo Webshare gives you the 
opportunity to select and notify one or more groups that there is an album 

Did you know?

You can share albums with friends and family without requiring them to log on to the HP 
Photo Webshare. To do this, create a visitor with only Email and Save Photos 
checked. When that visitor receives an email notification with a link to an album, they 
can go directly to the HP Photo Webshare home page using a single click of the email 
notification link.
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ready for viewing. For additional information, see Sharing an album on 
page 3-47.

To view groups

1 Log on to the HP Photo Webshare.
For more information, see Logging on to HP Photo Webshare on page 3-
34.

2 Click Groups in the upper right corner of the HP Photo Webshare to 
view a list of groups and the following information.
The Groups link is visible for Webshare Managers only. Visitors do not 
see the Groups link when they log on to Webshare.

Groups—visitors can be members of one or more groups. Groups 
allow Webshare Managers to share albums with a collection of 
visitors quickly and easily.
Delete—click the trash can to remove the group. Members of deleted 
groups do not have the ability to view any previously shared albums or 
new albums.
Edit—click to change group information.

Creating or Editing Groups
This page allows you to add a new group or change the information for an 
existing group.

To create or edit groups

1 Log on to the HP Photo Webshare.
For more information, see Logging on to HP Photo Webshare on page 3-
34.

2 Click Groups in the upper right corner of the HP Photo Webshare.
The Groups link is visible for Webshare Managers only. Visitors do not 
see the Groups link when they log on to Webshare.

3 Click Create Group or click Edit next to an existing group.
The following information displays for groups.

Group—type a unique name for the group. Group names can only 
be used once.
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The group name cannot be edited. If you need to change the group 
name, you must delete the group and create a new one. Be sure to 
add the appropriate visitors back to the group.
Members—members include visitors and network users with HP 
Photo Webshare accounts. Click Select All to select all members. 
Clicking a second time, deselects the members. You can also check 
individual names to select them. For additional information, see To 
create or edit visitors on page 3-39 or Creating a User on page 4-55.

Creating an Album to Share

To create an album to share over the Web

1 Log on to the HP Photo Webshare.
For more information, see Logging on to HP Photo Webshare on page 3-
34.

2 Click Create New Album. 
The wizard walks you through the process of:

Naming your Album
Adding Photos to Your Album
Sharing an album

Webshare Managers or visitors with permission to add photos can create 
new albums and add photos to existing albums.

Naming your Album
Give your album a name and description that are recognized by family and 
friends.

To name your album

1 Log on to the HP Photo Webshare.
For more information, see Logging on to HP Photo Webshare on page 3-
34.

2 Click Create New Album.
Type the following information.
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Name—the title of the album
Description—type a caption for your album. Optional. 

3 Click Next to go to the next step in creating albums, adding photos and 
videos.

Adding Photos to Your Album
Add and arrange photos and videos on this page. 

The Photos page is one of the tabs in the Create New Album wizard. 
Once an album is created, you can return to the Photos page by clicking 
Manage under each album on the HP Photo Webshare home page.

Supported photo and video files 
Photo Webshare supports the following file types:

• Photos: .jpg | .jpeg | .gif | .bmp | .png | .tif
• Videos: .mpg | .mpeg | .avi | .mov | .wmv
Note: Thumbnail and Preview images for .bmp and .tif have been converted 
to .jpg

To add photos and videos using Internet Explorer

1 Log on to the HP Photo Webshare.
For more information, see Logging on to HP Photo Webshare on page 3-
34.

2 Click Create New Album.
3 Click Add Photos.

When using Internet Explorer, you are prompted to install an ActiveX 
control the first time you add photos. Once installed, the Upload 
Photos dialog displays. 

The alternate Add photos to your album page displays if you 
choose to not install the ActiveX control. This page is also used if Firefox is 
your browser. For additional information, see To add photos using Firefox 
(or without the IE ActiveX control) on page 3-45.
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Figure 11: Upload photos

4 Locate the folder that contains the photos or videos you want to add.
Click Select All to select all the photos or videos in the folder. Clicking 
Select All a second time, deselects the files. You can also select or 
deselect individual files by clicking directly on each thumbnail. A check 
mark appears next to each selected photo or video. Use the rotate 
controls on each thumbnail to turn them clockwise or counterclockwise. 
Unsupported file types are not displayed.

5 Click Add Selected Photos.
You are returned to the Photos tab of the Create New Album wizard. 
Repeat these steps as many times as you like to add photos or videos to 
your album.

To add photos using Firefox (or without the IE ActiveX control)

1 Click Add Photos.
The Add photos to your album page displays.
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Figure 12: Add photos to your album page

2 Click Browse to navigate to each folder and select files until all of the 
photos or videos are selected.

3 Click Add Photos.
You are returned to the Photos tab of the Create New Album wizard. 
Repeat these steps as many times as you like to add photos or videos to 
your album.

To organize photos and videos

The Photos page displays all of the photos and videos in the album. You can 
make the changes below to photos or videos from this page. Click Next to 
share the album or Finish to return to the HP Photo Webshare home page 
when you are done making changes.
• Reorder—drag and drop pictures to reorder them.

Note: Files are added to the beginning of the album and may need to 
be reordered.

For additional information, see To create or edit visitors on page 3-39.
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• Rotate—select the photos to rotate. A check mark appears in the lower 
left corner of the selected pictures. Click a button to rotate photos 90º 
clockwise  or counterclockwise .

• Delete—select the photos to delete. A check mark appears in the lower 
left corner of the selected pictures. Click the trash can  to delete the 
pictures.

• Add captions—click Caption below a photo or video and type a title 
or description. Press Enter or click outside the caption to save it. Click the 
text again to change the caption.

• Add Photos—opens a page for selecting and inserting more photos or 
videos into the album.

If visitors have permission, they may add photos or videos to the album after 
it has been shared. Files added by visitors with auto-approve permission are 
placed at the beginning of the album and may need to be reordered. 

Files added by visitors without auto-approve permissions are placed in a 
section at the bottom of the Add Photos page. They remain there and cannot 
be viewed by other visitors until a Webshare Manager approves them. For 
additional information on visitor permissions or approving photos, see To 
create or edit visitors on page 3-39. 

Sharing an album
Albums are shared with visitors. Check the visitors with whom you want to 
share the album. Click Select All to share the album with all visitors. Click 
Select All a second time to deselect all visitors. Check a group to share the 
album with a set of visitors.

The Sharing page is one of the tabs in the Create New Album wizard. 
Once an album is created, you can return to the Sharing page by clicking 
Manage under each album on the HP Photo Webshare home page. The 
Photos page opens. Click Next to advance to the Sharing page or click the 
Share tab.

Albums are shared with visitors. If no visitors are listed, a Webshare 
Manager must add them. For additional information, see To create or edit 
visitors on page 3-39.
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Notifying Visitors by Email
Sends an email notification to visitors to let them know a new album has been 
created. If you make changes to an album later, you can come back to this 
page and send another notification.

The Notify page is one of the tabs in the Create New Album wizard. Once 
an album is created, you can return to the Notify page by clicking Manage 
under each album on the HP Photo Webshare home page. The Photos page 
opens. Click Next until you advance to the Notify page or click the Notify 
tab.

Figure 13: Sample email notification

• Groups— Check the groups with whom you want to share the album. 
Click Select All to share the album with all groups. Click Select All a 
second time to deselect all groups. Click the arrow next to each group to 
expand the group and see the visitors in that group. Select or deselect 
individual visitors with whom to share the album.

• To—You can directly type in email addresses to share with users who are 
not already visitors, and you will be prompted to setup a new visitor 
account. If you would like to notify existing visitors, ensure they are 
selected at the left for sharing and then select them from the drop down 
list.
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• Subject—type a subject line for the email notification. HP Photo 
Webshare puts the name of the album in the subject line if you do not 
type one.

• Message—type a message for the email notification. By default, this 
field is the album description.

Viewing and Saving Photos
Click an album picture or name on the HP Photo Webshare home page to 
access features for:
• Viewing photos
• Saving Photos
• Presenting Slideshows

Viewing photos
When you click an album picture or name in the HP Photo Webshare, a page 
displays for viewing the album’s photos.
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Figure 14: View photos page

To view photos

1 Log on to the HP Photo Webshare.
For more information, see Logging on to HP Photo Webshare on page 3-
34.

2 Click an album picture or name on the HP Photo Webshare home 
page.
A page displays for viewing the album’s photos.

Add Photos—inserts more photos or videos into the album. For more 
information, see Adding Photos to Your Album on page 3-44.
Save Photos—opens the Save Photos page where you can select 
and save photos to the computer from the HP Media Vault Server. This 
feature enables visitors and remote users to save pictures to their 
location. For more information, see Saving Photos on page 3-51.
Slideshow—enjoy viewing photos as full-screen images. 
Automatically or manually advance through the photos in your album, 
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making them a great way to show pictures to family and friends. For 
more information, see Presenting Slideshows on page 3-52.
View—click the left  or right  arrow to move the preview to the 
previous or next image.
Filmstrip—displays a set of images from the album. Click the left  
or right  arrow to page backward or forward through the photos.

Saving Photos
Select, size, and save photos from the HP Media Vault Server to your 
computer. This is especially useful for visitors and remote users who want a 
copy of the photo on their computer to view or manipulate.

To save photos

1 Log on to the HP Photo Webshare.
For more information, see Logging on to HP Photo Webshare on page 3-
34.

2 Click an album picture or name on the HP Photo Webshare home 
page.
A page displays for viewing the album’s photos.

3 Click Save Photos.
The Save Photos page displays with the following options.

Select All—selects all the photos in the album. Clicking a second 
time, deselects the photos. You can also select or deselect individual 
photos by clicking directly on each thumbnail. A check mark appears 
next to each selected photo.
Preview Size—reduces photos to at most 960 pixels on a side. If the 
original photo was smaller, then the original size and preview size are 
the same.

Note: Tif and Bmp previews are stored as jpg files

Original size—does not change the size of the photo. Saves the 
photo at the same size it was added to Webshare.
Save—saves the selected photos to the computer from the HP Media 
Vault Server. This feature enables visitors and remote users to save 
pictures to their location. If a single photo is selected, you can open or 
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save the graphic file. If multiple photos are selected, Webshare puts 
them in a zip file that you can open or save to your computer.
Cancel—clears the selection and returns to the view photo page.

Presenting Slideshows
Slideshows automatically or manually advance through the photos in your 
album, making them a great way to show pictures to family and friends.

To present slideshows

1 Log on to the HP Photo Webshare.
For more information, see Logging on to HP Photo Webshare on page 3-
34.

2 Click an album picture or name on the HP Photo Webshare home 
page.
A page displays for viewing the album’s photos.

3 Click Sideshow.
The Slideshow page displays with the following options.

Play—advances each photo based on the speed you selected. The 
Play button toggles to Pause when it is clicked.
Pause—stops the automatic advancement of photos. The Pause 
button toggles to Play when it is clicked.
Previous/Next—click left  or right  to move the slideshow to 
the previous or next image.
Beginning/End—click left  or right  to move the slideshow to 
the first or last image.
Speed—determines the number of seconds each photo displays 
before advancing to the next one during Play mode. Click a time to 
change the speed.

Changing a Visitor’s Password
When logged on as a visitor account, there is a change password link at the 
top left. Once logged in, visitors can change (or remove) their password as 
they wish.
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Frequently Asked Questions

• Where are my Webshare photos and videos stored on my HP Media 
Vault Server?
The files and photos for Webshare are stored in a separate location on 
the server. This location is not available through network shares to help 
ensure that the correct file management aspects are enforced.

• When I’m browsing to a location on my computer to add photos and 
videos to a Webshare album, I can’t see all of my files. Where are they?
Only photo and video file formats are visible when browsing to add files 
to albums. Other file types, such as documents or spreadsheets, are not 
displayed for selecting.

• What do I do if I forgot my Webshare user name or password?
For visitor accounts: Open the Webshare logon page. Type your email 
address in the Forgot your user name or password? box and 
click Send.
For Server accounts: Use the Server user management tool(s) to reset / 
change passwords for user accounts.

• What happens to the albums / files for accounts when they are deleted? 
When an account is deleted, all of the content remains and is the 
responsibility of the Webshare manager to either keep the remaining 
albums and photos and manage the sharing, or delete these items.
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4 Managing Users
What’s in this chapter
» Creating a User
» Editing a User
» Changing a User’s Folder Privileges
» Deleting a User
» Changing a Password
» Viewing User Information
» Enabling Remote Access

This chapter explains how to create and manage network user accounts. 

User accounts are required to access private shared folders. User accounts 
increase security on private shared folders by requiring passwords and setting 
read/write permissions for each user. User accounts are also required to log 
on to the HP Photo Webshare.

Creating a User

To create a user

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 On the Users tab, click Create User.
4 Type the User Name.

If the user already has an account on a network computer, use the same 
user name and password for the HP Media Vault. Using consistent login 
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information ensures users have immediate access to the Media Vault 
without having to log in to the network and then again to the Media 
Vault. If they are the same, their network login will automatically pass 
through to the Media Vault.
User names can only contain letters, numbers, or underscores. Spaces 
and other special characters are not permitted.

5 Type and confirm the Password.
The user uses this password whenever they access private shared folders 
or the Photo Webshare on the Media Vault.

6 Check Photo Webshare Manager to give the user the ability to 
manage webshare visitors and approve photos submitted by users.
If you do not check this box, the user can log on to Photo Webshare to:

view photos or videos,
save photos to their computer, or
view slideshows of photo albums.

Additional options can be turned on for users that do not have the Photo 
Webshare Manager box checked. These options must be turned on 
from within Photo Webshare. For additional information, see To create or 
edit visitors on page 3-39.

7 Select the Folder Access level for each private shared folder.
User’s do not have access to new or existing folders by default.

Full Access - The user can open, change, and create files and sub-
folders.
Read Only - The user can open files or folders but they cannot 
create, rename, or change them.
None - The user cannot see the shared folder or access it in any way.

8 Click Save.

Editing a User
Media Vault administrators can change user information at any time. Edit 
information when a user forgets their password or when you need to change 
access privileges to a shared folder.
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To edit a user

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 On the Users tab, locate the user you want to modify.
4 Click Edit.
5 The User Name cannot be edited.

To change a user’s name, delete the current user and create a new one.
6 Type and confirm the Password.

The user uses this password whenever they access private shared folders 
or the Photo Webshare on the Media Vault.

7 Check Photo Webshare Manager to give the user the ability to 
manage webshare visitors and approve photos submitted by users.

8 Select the Folder Access level for each private shared folder.
User’s do not have access to new or existing folders by default.

Full Access - The user can open, change, create, and delete files and 
sub-folders.
Read Only - The user can open files or folders but they cannot 
create, rename, change, or delete them.
None - The user cannot see the folder or access it in any way.

9 Click Save.

Changing a User’s Folder Privileges
User’s have access privileges for each private shared folder on your HP 
Media Vault. Initially, users do not have access to existing shared folders or 
any new folders you create. You must grant folder permissions to users before 
they can see the folder or its contents.
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To change privileges for multiple users on a single folder

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 On the Shared Folders tab, locate the folder you want to modify.
4 Click Edit.

Note: The Folder Access must be set to Private in order to set 
sharing privileges for individual users. If you choose to set the Folder 
Access to Public, you can set one password that all users share and 
choose who you tell the password to.

5 Select the Folder Access level for each shared folder.
Only private folders show in this list. User’s do not have access to new or 
existing folders by default.

Full Access - The user can open, change, and create files and sub-
folders.
Read Only - The user can open files or folders but they cannot 
create, rename, or change them.
None - The user cannot see the folder or access it in any way.

6 Click Save.

To change privileges for a single user across multiple folders

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 On the Users tab, locate the user you want to modify.
4 Click Edit.
5 Select the Folder Access level for each shared folder.

User’s do not have access to new or existing folders by default.



4-59

Full Access - The user can open, change, and create files and sub-
folders.
Read Only - The user can open files or folders but they cannot 
create, rename, or change them.
None - The user cannot see the folder or access it in any way.

6 Click Save.

Deleting a User
Users must have an account to access private shared folders or to access 
Photo Webshare as a visitor or Photo Webshare Manager. Once a user is 
deleted, they lose these permissions.

To delete a user

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 On the Users tab, locate the user you want to delete.
4 Click Delete.
5 Type the user name in the dialog to confirm the deletion and click OK.

If the dialog does not display, check to see if your browser pop-up blocker 
is on.

Changing a Password
Users require individual passwords to access private shared folders. Media 
Vault administrators can change user passwords if the user forgets the 
password or if the password is no longer secure.

To change a password

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
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You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 On the Users tab, locate the user you want to modify.
4 Click Edit.
5 Type and confirm the new Password.
6 Click Save.

Viewing User Information

Viewing Users

1 The following information displays for users.
User Name 
A unique user name. It may be the same as a network computer user 
name. 
Photo Webshare Manager
Webshare managers have the ability to manage webshare visitors 
and approve photos submitted by users.
Actions
Select to Edit or Delete a user name.

2 Create, edit or delete user names from this page. 

Enabling Remote Access
Home users can be set up to access the Administration Console, HP Photo 
Webshare, and Shared Folders while away from home. See, Remote Access 
on page 9-99 for information on setting up and using remote access.
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5 Managing Shared Folders
What’s in this chapter
» Viewing Shared Folders
» Creating a Shared folder
» Editing a Shared Folder
» Deleting a Shared Folder
» Enhance Security on your Shared Folders

Shared folders are the HP Media Vault’s primary resources shared on your 
network. Similar to folders on your computer, you can set up shared folders to 
store and share files or to restrict access to certain network users.

Viewing Shared Folders
The following instructions tell you how to view information about shared 
folders.

To view shared folders

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 Click the Shared Folders tab.
The first time you enter the configuration screens and before you’ve 
created other shared folders, there are the five pre-configured folders: 
Backup, Documents, Music, Photos, and Videos.

The following shared folder information displays.
• Folder Name
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The Media Vault comes with five shared folders already created: Backup, 
Documents, Music, Photos, and Videos. These initial folders cannot be 
deleted or renamed.

• Type
• Mirrored - A mirrored share automatically stores an exact copy of files 

on a second hard drive. Using a mirrored share reduces the chance of 
you losing critical files if one hard drive fails.

• Non-mirrored - A non-mirrored share is stored on a single hard drive. 
The HP Media Vault does not automatically maintain a copy of these files 
on a second hard drive.

• USB - You can add external USB storage devices to any of the HP Media 
Vault’s USB ports. Small USB devices, such as key disks and jump drives, 
can be attached. Likewise, portable devices, such as cameras and 
phones, can be attached if the Media Vault detects those devices as USB 
storage devices. If you have any questions, check with the USB 
manufacturer to verify that the device is classified as a USB storage 
device.

• Access
Public - Public folders give everyone on your network equal access. 
However, you can check Protect Shared Folder and create a 
shared folder password to add some security. With password 
protection enabled, all network users enter the same password to 
access the shared folder.
To browse shared folders from an Internet browser on a computer 
within your home network or remotely, the public shared folders must 
be password enabled or the folder must be set to private (see below). 
For additional information, see To use network addressing to browse 
on page 6-76. For instance, if you registered MyFamily.hpshare.net for 
your HP Media Vault, you would use this address to connect to your 
server using remote access.
Private - Private shared folders are the default. They are more secure 
since you create network users on the Users tab and you define 
"access privileges" for each user for each shared folder. It is 
recommended that you use private shared folders if you are using 
remote access since each user is assigned a password, increasing the 
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security level of your Media Vault. For additional information, see 
Creating a User on page 4-55.

• Media Streaming
Media streaming sends media—music, photos and video files—from the 
Media Vault to DMA-enabled devices, such as your TV or stereo, that can 
play the media. Music in media streaming-enabled folders can also be 
listened to in iTunes.
Note: DRM-protected music cannot be shared from the Media Vault with 
iTunes or streamed to DMA-enabled devices.

• Actions
Edit - Change features associated with the shared folder.
Delete - Deleting a shared folder automatically deletes all of the sub-
folders and files stored in that shared folder.

Note: The Backup, Documents, Music, Photos, and Videos shared 
folders cannot be renamed or deleted.

Creating a Shared Folder
Create shared folders to organize content on your HP Media Vault. Folders 
can have public or private permissions. Private folders have more security and 
require a user name and password to log on.

To create a shared folder

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 On the Shared Folders tab, click Create Shared Folder.
4 In the Folder Name box, type a descriptive name.

Typing a Comment is optional.
5 Select Public or Private Folder Access.
• Public - Public folders give everyone on your network equal access. 

However, you can check Protect Shared Folder and create a shared 
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folder password to add some security. With password protection enabled, 
all network users enter the same password to access the shared folder.
To browse shared folders from an Internet browser on a computer within 
your home network or remotely, the public shared folders must be 
password enabled or the folder must be set to private (see below). For 
additional information, see To use network addressing to browse on 
page 76. For instance, if you registered MyFamily.hpshare.net for your 
HP Media Vault, you would use this address to connect to your server 
using remote access.

• Private - Private shared folders are the default. They are more secure 
since you create network users on the Users tab and you define "access 
privileges" for each user for each shared folder. It is recommended that 
you use private shared folders if you are using remote access since each 
user is assigned a password, increasing the security level of your Media 
Vault. For additional information, see Creating a User on page 55.

6 Select where you want the shared folder to reside.
The options available to you depend on how your Media Vault is setup. 
The HP Media Vault is initially set up with one non-mirrored drive.

• Mirrored - A mirrored share automatically stores an exact copy of files 
on a second hard drive. Using a mirrored share reduces the chance of 
you losing critical files if one hard drive fails.

• Non-mirrored - A non-mirrored share is stored on a single hard drive. 
The HP Media Vault does not automatically maintain a copy of these files 
on a second hard drive.

• USB - You can add external USB storage devices to any of the HP Media 
Vault’s USB ports. Small USB devices, such as key disks and jump drives, 
can be attached. Likewise, portable devices, such as cameras and 
phones, can be attached if the Media Vault detects those devices as USB 
storage devices. If you have any questions, check with the USB 
manufacturer to verify that the device is classified as a USB storage 
device.
Note: USB devices only appear on this page if they were formatted 
using the HP Media Vault Administration Console.

 For additional information, see Formatting an External USB Device on 
page 10-129.
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7 Check Enable Media Streaming to share the folder’s contents with a 
DMA-enabled device or iTunes. 
Streaming to DMA-enabled Devices. Check this box if you have a 
Digital Media Adaptor (DMA) and want to stream photos, music, or 
videos in this folder to your television or stereo. Media streaming looks for 
files of a certain type—photos, music, or videos—within the specified 
folder. Therefore, music must be placed in the music folder or a sub-folder 
of the music folder. Photos must be within the Photos folder. Videos must 
be in the videos folder.
For example, if a .jpg (a photo file format) is placed in the music folder it 
will not be streamed as a photo. It is ignored since it is not in the photos 
folder.
Streaming to iTunes. You can also check Enable Media 
Streaming if you are placing music in this folder and want to listen to it 
using iTunes. Only music files that are not DRM-protected can be 
streamed to iTunes. Music purchased from the iTunes store or some other 
online stores cannot be streamed to iTunes from the Media Vault. 
Likewise, photos or videos cannot be streamed to iTunes, just music files.

8 Click Save.

Related Information
• Creating a User on page 4-55
• Streaming Media to your Entertainment Center on page 8-94

Editing a Shared Folder
Edit a folder to change how information is shared or stored.

To edit a shared folder

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 On the Shared Folders tab, locate the folder you want to modify and 
click Edit.
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4 The Folder Name cannot be edited.
To change a folder name, delete the current folder and create a new one. 
Deleting a shared folder, deletes that folder and all of the files and 
subfolders within it.
Typing a Comment is optional.

5 Select Public or Private Folder Access.
• Public - Public folders give everyone on your network equal access. 

However, you can check Protect Shared Folder and create a shared 
folder password to add some security. With password protection enabled, 
all network users enter the same password to access the shared folder.
To browse shared folders from an Internet browser on a computer within 
your home network or remotely, the public shared folders must be 
password enabled or the folder must be set to private (see below). For 
additional information, see To use network addressing to browse on 
page 76. For instance, if you registered MyFamily.hpshare.net for your 
HP Media Vault, you would use this address to connect to your server 
using remote access.

• Private - Private shared folders are the default. They are more secure 
since you create network users on the Users tab and you define "access 
privileges" for each user for each shared folder. It is recommended that 
you use private shared folders if you are using remote access since each 
user is assigned a password, increasing the security level of your Media 
Vault. For additional information, see Creating a User on page 55.
Note: If you add a mirrored drive to your HP Media Vault and it is the 
same size as the system drive, you do not have the option to create non-
mirrored shared folders. All folders are mirrored.

If the mirrored drive is larger than the system drive, the additional storage 
space is non-mirrored and can contain non-mirrored shared folders. Once 
a shared folder is created in the mirrored or non-mirrored disk space, it 
cannot be moved. The HP Media Vault default shared folders, Backup, 
Documents, Music, Photos, and Videos, always exist in mirrored disk 
space on a Media Vault with mirrored drives.

6 Check Enable Media Streaming to share the folder’s contents with a 
DMA-enabled device or iTunes.
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Streaming to DMA-enabled Devices. Check this box if you have a 
Digital Media Adaptor (DMA) and want to stream photos, music, or 
videos in this folder to your television or stereo. Media streaming looks for 
files of a certain type—photos, music, or videos—within the specified 
folder. Therefore, music must be placed in the music folder or a sub-folder 
of the music folder. Photos must be within the Photos folder. Videos must 
be in the videos folder.
For example, if a .jpg (a photo file format) is placed in the music folder it 
will not be streamed as a photo. It is ignored since it is not in the photos 
folder.
Streaming to iTunes. You can also check Enable Media 
Streaming if you are placing music in this folder and want to listen to it 
using iTunes. Only music files that are not DRM-protected can be 
streamed to iTunes. Music purchased from the iTunes store or some other 
online stores cannot be streamed to iTunes from the Media Vault. 
Likewise, photos or videos cannot be streamed to iTunes, just music files.

7 Click Save.

Deleting a Shared Folder
You may want to backup the information in the shared folder before you 
delete it. Once the shared folder is deleted, all of the sub-folders and files 
within it are removed from your Media Vault.
Note: The Media Vault comes with five shared folders already created: 
Backup, Documents, Music, Photos, and Videos. These initial folders cannot 
be deleted.

To delete a shared folder

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 On the Shared Folders tab, locate the folder you want to delete.
4 Click Delete.
5 Type the folder name in the dialog to confirm the deletion and click OK.
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Enhance Security on your Shared Folders
The HP Media Vault comes with different options for securing folders and files 
saved to the server. You can permit everyone on your network access to all 
your server’s files, or you can set the access levels on individual folders that 
contain sensitive information so that only you have access to those files.

The server’s two security options for shared folders are:
• Private
• Public

Public Shared Folders
Public shared folders have the lowest level of security. In public shared 
folders, everyone on your network has equal access to all your folders. 
However, you can add one level of security to public shared folders by 
password protecting them. With password protection enabled, network users 
must enter the name of the shared folder as the user name and the 
appropriate password before gaining access to the folder.

Private Shared Folders
Private shared folders are the default. They have a more restrictive security 
level because you grant "access privileges" for each defined network user on 
each shared folder.

Let's say you store all your financial files on the server. All your network users 
store their music files to the server so that they can download songs only once 
from the Internet. But you don't want all your network users to have access to 
your financial files. In this case, you would create separate user names for 
each user giving them "Full access" to the shared folders containing music. 
You would then assign "No access" to these users on shared folders that 
contain financial files.
Note: Private shared folders require a more thorough understanding of the 
server's networking features, and occasional maintenance of changes. Before 
deciding to enable private shared folders, make sure that you understand the 
configuration screens.
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To select private mode

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 On the Shared Folders tab, locate the folder you want to change.
4 Click Edit.
5 Click Private mode.
6 Select permissions for each user.

As administrator, you must create user names for each user. You must also 
assign one of the following three privilege levels for every user, for every 
shared folder on the server:

Full access
Read-only access
No access

Note: If users are not created, you can assign their folder privileges as 
you create each user. 

For additional information, see Creating a User on page 4-55.

7 Click Save.
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6 Organizing and Browsing 
Folders

What’s in this chapter
» Organizing Folders
» Mapping Drive Letters to Shared Folders
» Browsing Folders
» Transferring Files from Computer to Computer
» Connecting to the Media Vault from a Linux System

» Connecting to the Media Vault from a Macintosh

On your computer, you browse your file system to find, open, and save files to 
your hard drive. You can also use your computer to browse to the shared 
folders on your HP Media Vault. After browsing to your server’s shared 
folders, you can save folders and files to them.

You can use several methods to browse to and access your server’s shared 
folders.

Organizing Folders
The HP Media Vault comes pre-configured with five top-level shared folders: 
Backup, Documents, Music, Photos, and Videos. These folders are pre-named 
to help you get started saving and organizing your files.

Additionally, the top-level shared folders are designed for specific purposes. 
For instance, the backup application that comes with the Media Vault places 
backup files in the backup folder. Streaming media features rely on music 
being in the music folder, photos being in the photos folder, and videos being 
in the videos folder.

Consider creating sub-folders within the top-level folders to organize your 
content and reduce the time it takes to find information on your Media Vault.
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You can not rename or delete Backup, Documents, Music, Photos, and Videos 
folders. Before doing so, please read the recommendations in the following 
table:

To create sub-folders

Creating sub-folders on your computer and saving them to the Media Vault 
folder on your server provides an easy way to organize your media files. 
Follow the example below to learn how to create sub-folders and save them to 
the Media Vault.

In this example, you create sub-folders in the Music folder for storing 
categories of music.

1 On your computer, browse to the shared Music folder.
For information on how to browse to the Music folder, see Browsing 
Folders on page 6-75.

2 Do one of the following:

Table 3: Recommendation for using default folders

Shared Folders Recommended Files

Documents Use this folder to store any important files that you want to 
share across your network.

Music
Photos
Videos

HP configured these folders for media streaming to home 
entertainment centers and to iTunes.
iTunes aggregator puts files into the Music folder.
Media streaming looks for files of a certain type—photos, 
music, or videos—within the specified folder. Therefore, music 
must be placed in the music folder or a sub-folder of the music 
folder. Photos must be within the Photos folder. Videos must 
be in the videos folder.
For example, if a .jpg (a photo file format) is placed in the 
music folder it will not be streamed as a photo. It is ignored 
since it is not in the photos folder.

Backup NTI's DriveBackup! defaults to this shared folder to store 
computer system backup files. These are large files containing 
all of your hard drive's data.
In addition, NTI Shadow simple backups also default to this 
shared folder to store folder and file backups.



6-73

Windows XP: Click the File menu, click New, Folder, and then 
name the sub-folder Jazz. Click somewhere else to clear the highlight.
Windows Vista: Click the Organize menu, click New Folder, 
and then enter Blues in the highlighted box. Click somewhere else to 
clear the highlight.

Mapping Drive Letters to Shared Folders
Mapping drive letters means assigning "letters" to the names of shared 
folders. Mapping drive letters is one of the easiest ways to manage files 
because you can save files and folders to mapped drive letters just as you can 
to other drive letters on your computer, such as the C: and D: drives.

You can map letters by using one of the following methods.
• To map a drive letter using HP software
• To map a drive letter using Windows XP
• To disconnect a drive letter using Windows XP
• To map a drive letter using Windows Vista

To map a drive letter using HP software

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Map Drive Letter.
The HP Media Vault Drive Mapper opens.

3 Click a shared folder in the Select shared folder box.
4 Select a drive letter from the Select Drive Letter drop-down list.

Mapping drives usually defaults to the letter Z:, but you can select any 
drive letter.

5 Click Map Drive.
6 Click Close when you are finished mapping drive letters to shared 

folders.
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To map a drive letter using Windows XP

1 Click Start, All Programs, Accessories, Windows Explorer, My 
Computer.

2 Click the Tools menu, Map Network Drive...
3 Select a letter from the Drive drop-down list.
4 In the Folder box, browse to your shared folder or type the Uniform 

Naming Convention (UNC).
For example: enter \\HPMediaVault\Documents (HPMediaVault is the 
device name; Documents is the name of the shared folder.)

5 Check Reconnect at logon.
6 Click Finish.
Note: Special considerations when mapping drive letters:

• If you changed the name of your server, enter the new name instead of 
HPMediaVault in step 4 above.

• When mapping drive letters to shared folders that are password 
protected, you must complete an additional step: enter the shared folder’s 
user name and password when prompted. Use the shared folder’s name 
as the user name. The password is the one you created. For additional 
information, see Creating a Shared folder on page 5-63.

• If your server is configured for security and you map drive letters to 
shared folders, you might have to enter a user name and password. You 
do not have to enter a user name and password if you already logged 
onto your Windows computer with the same user name/password.

To disconnect a drive letter using Windows XP

1 Click Start, All Programs, Accessories, Windows Explorer, My 
Computer.

2 Right-click on the icon for the mapped drive.
3 Click Disconnect.

This removes the drive letter; you can still access the resource from My 
Network Places.

To map a drive letter using Windows Vista

Before taking the following steps be sure that Network discovery is turned on.
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1 Click Start menu, Computer.
2 In the tool bar, click Map Network Drive.
3 Mapping drives usually defaults to the letter Z:, but you can select another 

drive letter by following the next two steps:
4 In the Folder box, browse to your shared folder or type the Uniform 

Naming Convention (UNC).
For example: enter \\HPMediaVault\Documents (HPMediaVault is the 
device name; Documents is the name of the shared folder.)

5 Check Reconnect at logon.

6 Click Finish.

Browsing Folders
There are several ways to browse folders on the HP Media Vault. This section 
describes the following options.
• To browse folders from the Control Center
• To use My Network Places in Windows XP to browse
• To use Network in Windows Vista to browse
• To use network addressing to browse
• To use Windows Explorer to browse
• To use Windows Vista Explorer to browse

To browse folders from the Control Center

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Status tab, click one of the following icons.
Server—click to browse all shared folders on the HP Media Vault
Documents—click to browse the Documents folder
Photos—click to browse the Photos folder
Music—click to browse the Music folder
Videos—click to browse the Videos folder

A browser window opens showing you a list of your shared folders.
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3 Double-click the name of a shared folder to browse its contents.
If you haven’t saved any files to the shared folder, the folder is empty.

To use My Network Places in Windows XP to browse

You must map your network drives before completing this procedure.

1 At the computer, click Start, My Computer, My Network Places.
2 In the Name column, locate the shared folder you want to open.

For example, if opening the Documents shared folder, My Network 
Places lists the name as Documents on HPMediaVault.

3 Click Documents on HPMediaVault to open the Documents 
shared folder and browse its contents.
The network address displays in the address bar and should be 
\\HPMediaVault\Documents.

To use Network in Windows Vista to browse

1 At the computer, click Start menu, Network.
If network discovery is turned off, a message displays in the notification 
bar. Click the notification bar, and then click Turn on network discovery 
and file sharing.

2 Double-click the name of your server. For example: HPMediaVault
Note: The Network window may also display the name of the HP 
Media Vault. Click the server, not the media server.

3 Double-click the name of a shared folder.
4 Click Documents to open Documents and see the files stored in this folder. 

(If you haven’t saved any files to Documents, the window is empty; 
otherwise you see a list of saved files.)

5 After opening Documents, look at the Windows Address bar to see the 
network path of your server.

To use network addressing to browse

Network addressing means that you can access resources on your network 
by entering their "addresses" in a browser’s Address bar.
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1 Open a standard browser window, such as Internet Explorer, Netscape, 
or Firefox.

2 Delete everything in the Address bar.
3 In the Address bar, enter \\HPMediaVault\Documents, and then press 

Enter. 
For example: enter \\HPMediaVault\Documents (HPMediaVault is the 
device name; Documents is the name of the shared folder.)
Note: In Windows Vista, you can use this method from any window 
containing an Address bar.

Network addressing uses the Uniform Naming Convention (UNC) format. 
This format looks like the following:
\\device name\share name. In this example, HPMediaVault is the device 
name, and Documents is the shared folder or "share name." (For those 
more familiar with networking terms, the word "Share" is often used 
instead of "shared folder.")
Note: The server comes pre-configured with the name: HPMediaVault. 
To change the name of your server, see Change the name of your HP 
Media Vault.

To use Windows Explorer to browse

If you mapped drive letters to shared folders, you can browse to those folders 
using Windows Explorer.

1 Click Start, All Programs, Accessories, Windows Explorer, My 
Computer.

2 Double-click the name of the shared folder you want to open. The drive 
letter is located at the end of the name.

To use Windows Vista Explorer to browse

If you mapped drive letters to the Backup, Documents, Music, Photos, and 
Videos folders, you can browse to those folders using Windows Explorer.

1 Click Start, Computer.
2 Double-click the name of the shared folder you want to open. The drive 

letter is located at the end of the name.



Version 6-78

Transferring Files from Computer to Computer
Your HP Media Vault can help you simplify transferring files and settings from 
an old computer to a new computer.

Using a feature found in the Windows XP operating system called the Files 
and Settings Transfer Wizard, you can transfer files, folders, and 
settings for Internet Explorer and Outlook Express in addition to desktop and 
display settings, dial-up connections, and other types of settings to a file on 
your server. On the new computer, you access this file stored on your server 
and transfer the settings and files to your new computer. The Windows 
Files and Settings Transfer Wizard must be available on the Windows 
operating system on both your old and new computers.

Steps for Windows XP

On your old computer

1 Click Start, All Programs, Accessories, System Tools, Files & 
Settings Transfer Wizard. 
The Wizard’s first dialog box appears.

2 Click Next.
3 Click Old Computer.
4 Click Next.
5 Click Other.
6 Either Browse to a folder on your server, or use the Uniform Naming 

Convention (UNC) to type in the path.
For example, to save your settings to Documents, type in the Folder or 
drive: box: \\HPMediaVault\Documents.

7 Click Next.
8 Click one of the following:

Settings only
Files only
Both files and settings
Let me select a custom list of files and settings when I click Next (for 
advanced users.) If you click on this option, you are asked to select 
specific Settings, Folders, Files and File Types that you wish to transfer.
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9 Click Next.
10 Click Next after reading any messages that appear on this screen.

Wait while the wizard collects your files and settings. Depending on the 
size and type of the files you’re saving, this could take several minutes.

11 Click Finish.

On your new computer

1 Follow steps 1-2 above to run the Files & Settings Transfer Wizard 
on your new computer.

2 Click New Computer.
3 Click I don’t need the Wizard Disk, I have already collected my files 

and settings from my old computer.

4 Click Next.
5 Click Other. 
6 Browse to or type in the path that you entered in step 6 above. 

This path directs the new computer to the shared folder on your server 
where you stored your files, folders and settings. If you used the example 
above, the path is the same: \\HPMediaVault\Documents.

7 Click Next.
Wait while the wizard transfers your files and settings to your new 
computer. Depending on the size and type of the files you’re transferring, 
this could take several minutes.

8 Click Finish.

Steps for Windows Vista
Windows Easy transfer can use one of the following methods to migrate files 
and settings: 
• Use a Easy Transfer Cable, a special USB cable that can connect two 

computers
• Network Connection 
• CD, DVD, or other Removable Media
Note: If you are running any other programs, you will be prompted to close 
these programs. You can save your work in each program, and then close the 
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programs individually. You can also click Close All in Windows Easy 
Transfer to close these programs immediately. 

On the old computer

Method 1: Use an Easy Transfer Cable.

1 Click Start, All Programs, Accessories, System Tools, Windows 
Easy Transfer.
If a "User Account Control" dialog box opens, click Next.

2 A dialog box appears detailing what can be moved and 2 links:
Which versions of Windows work with Windows Easy Transfer?
Go online to learn how to improve you transfer experience.

3 Click Next.
4 Click Start a new transfer. 
5 Click This is my old computer. 
6 The next dialog box appears giving the three choices for accomplishing 

the transfer; choose Use an Easy Transfer Cable.
7 A dialog box appears showing how to connect the cable. 
8 Install a USB cable that can connect the two computers, and install the 

any drivers that are appropriate for your situation.
9 Start Windows Easy Transfer to transfer files and settings to the 

destination computer. 

Method 2: Use a network drive to migrate files and settings.

1 Click Start, All Programs, Accessories, System Tools, Windows 
Easy Transfer.
If a "User Account Control" dialog box opens, click Next.

2 A dialog box appears detailing what can be moved and 2 links:
Which versions of Windows work with Windows Easy Transfer?
Go online to learn how to improve you transfer experience.

3 Click Next.
4 Click Start a new transfer. 
5 Click This is my old computer. 
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6 The next dialog box appears giving the three choices for accomplishing 
the transfer; choose Transfer directly using a network 
connection.

7 Click Next.
8 Click Through a network. 
9 Click Connect directly via network to start the migration.

Note: Click Save to network location if you want to store the files and 
the settings in a file that will be loaded later. If you want to store the files 
and the settings on a network drive, you will be prompted to provide the 
path where you want to store the files and the settings.

10 Click Everything - all user accounts, files, and program settings 
(recommended) to migrate all the files and the settings. If you want to 
determine exactly which files and settings that you want to migrate, click 
Only my user account, files, and program settings, or click 
Custom. 

11  Review the list that contains the files and the settings that you want to 
migrate, and then click Start. To add or to remove files or settings from 
the list, click Customize. 

12 Click Close after Windows Easy Transfer has completed the 
migration of files and settings to the destination computer. 

Method 3: Use CD, DVD or removable media to migrate files 
and settings.

1 Click Start, All Programs, Accessories, System Tools, Windows 
Easy Transfer.
If a "User Account Control" dialog box opens, click Next.

2 A dialog box appears detailing what can be moved and 2 links:
Which versions of Windows work with Windows Easy Transfer?
Go online to learn how to improve you transfer experience.

3 Click Next.
4 Click Start a new transfer. 
5 Click This is my old computer. 
6 Click Next.
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7 Determine the appropriate removable transfer media, and then click On a 
CD or other removable media, such as a flash drive.

8 Click To a network drive to save the files and the settings to 
a folder that is on the removable drive.

9 In Where do you want to save your files, type the path to a folder on the 
removable drive, and then click Next.

10 Click Everything - all user accounts, files, and program settings 
(recommended) to migrate all the files and the settings. If you want to 
determine exactly which files and settings that you want to migrate, click 
Only my user account, files, and program settings, or click 
Custom. 

11 Review the list that contains the files and the settings that you want to 
migrate, and then click Start. To add or to remove files or settings from 
the list, click Customize.

12 Click Close after Windows Easy Transfer has completed 
migrating files and settings. 

13 Connect the removable media to the destination computer. 
14 Start Windows Easy Transfer, and then click Next.
15 Click Continue a transfer in progress.
16 In Where did you copy your files, click Removable media. If the 

Removable media option is unavailable, click Network Drive, and 
then click Next. 

17 In Locate your saved files, type the path where you saved the files and the 
settings. You can also click Browse to locate the files and the settings. 
Click Next after you have located the files and the settings. 

18 Select the user names on the destination computer that match the user 
names on the source computer. If there is not any user account that is 
created on the destination computer, you may have to create new 
accounts. To create an account on the local computer, directly type a user 
name. To create a profile or a domain user, type a user name in the 
following format: domain\user. 

19 In Choose the drives for files on your new computer, select the destination 
drive for each source drive. 
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20 Review the list that contains the files and the settings that you want to 
migrate, and then click Start. To add or remove files or settings from the 
list, click Customize. 

21 Click Close after Windows Easy Transfer has completed 
migrating files and settings. 

Connecting to the Media Vault from a Linux System
This topic provides general guidelines and instructions on how to access the 
shared folders and configuration screens on the HP Media Vault from a Linux 
system. The particular steps needed to configure a Linux system for connection 
to the server may vary depending on the particular Linux installation.

Connecting to HP Media Vault using Samba
Samba provides a simple and secure way of connecting a Linux computer to 
the server using the SMB (server Message Block) and CIFS (Common Internet 
File System) protocols. The SMB network protocol is the native file-sharing 
protocol for Windows. CIFS defines a standard remote file-system access 
protocol for use over a network.

To use Samba, the Linux system must have Samba installed. For information 
about how to install Samba, see the documentation or main pages included 
with the Linux distribution.

Using a Linux graphical interface to connect
Linux distributions have numerous versions and graphical interfaces. 
Consequently, it is not possible to provide specific steps when using a 
graphical interface to connect a Linux system to the server. General steps for 
connection include using a network browser to find the server.
Note: If a firewall is running, turn it off or configure the system to allow 
Samba to connect to the SMB Shares.

The path to the server is as follows:
• Domain - default, Windows Network
• Workgroup - default, WORKGROUP
• Machines - default, HPMediaVault

If any of these default names have changed, use the new name.
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Using an IP Address or NetBIOS name to access the HP 
Media Vault
Connecting to the server requires either the server's IP address or NetBIOS 
name. NetBIOS is an acronym for Network Basic Input/Output System. The 
advantage of using the NetBIOS name is that even if the server's IP address 
changes, the Linux system can find the server. The following two sections 
describe each method.

Obtaining the HP Media Vault’s IP address

The IP address for the server can be found on the router's configuration 
screens, usually under DHCP Client Table or Show Connected Devices.

Using the NetBIOS name instead of the IP address

Some Linux installations, such as Ubuntu, may not be able to find the server 
by name without additional configuration. The default NetBIOS name for the 
HP Media Vault is HPMediaVault. To use the NetBIOS name, take the 
following steps:

1 First, check if the Linux system can already resolve the NetBIOS name of 
the server.
a Open a terminal session.
b Type ping HPMediaVault.

2 If pinging fails, edit the nsswitch.conf file, as follows:
a Become root.
b In a terminal session, edit the /etc/nsswitch.conf file.
c In the nsswitch.conf file, add wins to the following line:

hosts: files dns
so it reads
hosts: wins files dns

3 Install winbind, which provides Name Service Switch capability.
4 To ensure that the installation works, ping the server:

ping HPMediaVault
It is now much easier to mount volumes or access configuration screens 
because the IP address does not have to be known.
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Connecting to HP Media Vault using Samba command 
lines
The method described here is not persistent. To have the Linux system 
automatically connect to the server every time it is rebooted, see the 
documentation or main pages for the Linux distribution.

Take the following steps to connect a Linux system to the server:

1 Open a Terminal session.
2 Become root.
3 If necessary install the Samba plug-in.
4 Create a directory for the shared files.

Example: mkdir /mnt/sharefiles
5 Mount the server shared folder to the Linux computer, using the following 

syntax:
mount -t smbfs //HPMediaVault/sharename /mountpoint/sharedirectory
NetBIOS name example: mount -t smbfs //HPMediaVault/Documents /
mnt/sharefiles
IP address example: mount -t smbfs //192.168.1.102/Documents /mnt/
sharefiles
Note: Documents is one of the default shared folders on the server.

Accessing the HP Media Vault’s Administration Console
To access the server's configuration screen, use a browser such as FireFox or 
Konqueror.

1 Open the web browser.
2 In the Location box, enter the IP address or name of the server.

IP address example: http://192.168.1.100
NetBIOS name example: http://HPMediaVault
Note: If the web browser cannot find the server with the NetBIOS name, 
the firewall may be blocking the request. If the Linux system has just been 
configured to use the NetBIOS name, the web browser may require 
restarting.
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The web browser displays The Welcome Page of the Administration 
Console.

Connecting to the Media Vault from a Macintosh
You can configure a Macintosh computer to access the shared folders and 
configuration screens on the HP Media Vault. These instructions apply only to 
computers with the latest Macintosh OS X operating system.

To map shared folders from a Macintosh

1 In the Finder, click Go, Connect to server.
2 In the Connect to server dialog box, click Browse.
3 In the Network window, click WORKGROUP, HPMediaVault.

Note: WORKGROUP is the default name of the workgroup. If this name 
has been changed, use the new name.

4 In the panel that shows the available shares, click Connect.
5 In the drop-down list on the Shared Volume window, select a shared 

volume, then click OK.
6 In the SMB/CIFS File System Authentication window, enter the 

password if it is required, and click OK.
7 Repeat steps 5 and 6 for each shared folder.

To access the HP Media Vault’s configuration screens

1 Open a web browser, such as Safari or Firefox.
2 In the Location box, enter the IP address or name of the server.
3 IP address example: http://192.168.1.101
4 Name example: http://HPMediaVault

Note: The IP address for the server can be found on your router's 
configuration screens, usually under DHCP Client Table or Show 
Connected Devices.

The web browser displays either The Welcome Page of the Administration 
Console.
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7 Networking
What’s in this chapter
» Viewing Network Settings
» Editing Network Settings
» Securing Your Media Vault from Intruders

Viewing Network Settings
Displays information for how your HP Media Vault connects to the network.

To view network settings

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 Click the Network tab to view settings.

The following network settings information displays.
• Workgroup name

The name of the Windows workgroup that all of your computers belong 
to.

• Secure HTTP
Remote access to shared folders or Webshare on the HP Media Vault is 
faster using HTTP. However, some Internet service providers require secure 
HTTP. If secure HTTP is enabled on your Media Vault, you must type 
HTTPS:\\servername when accessing the Media Vault remotely.

• IP Settings, either automatically or manually assigned
Automatically assign IP settings (DHCP)
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This is the default setting for the Media Vault. When this option is 
selected:
– The Media Vault automatically acquires its IP address and other 

settings from the DHCP (Dynamic Host Configuration Protocol) 
server on your network.

– The values of the IP Address, Gateway server, Subnet Mask, Domain 
Extension, DNS servers, and WINS servers set by the DHCP server 
are displayed.

Manually assign IP settings
If you use a static IP address, you may want to manually configure the 
IP settings on the Media Vault. This should be done only by 
experienced network administrators.

• IP Address
A number that uniquely identifies devices, such as computers, on a 
network.

• Gateway
The IP address for the default gateway. This is the address of a local IP 
router on the same network as this computer that is used to forward traffic 
to destinations beyond the local network.

• Subnet Mask
Identifies the portion of the network IP address that can be used for 
subnetworks.

• Domain Ext
A domain extension is an optional part of a network name used to 
logically divide a large network into smaller networks.

• DNS Server 1
The primary server that associates network names with IP addresses.

• DNS Server 2
The alternate or secondary server that associates network names with IP 
addresses.
Note: Entering two DNS servers is recommended for stability.

• WINS Server 1
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WINS (Windows Internet Naming Service) is a server that converts 
NetBIOS network names to IP addresses.

• WINS Server 2
WINS (Windows Internet Naming Service) is a server that converts 
NetBIOS network names to IP addresses.

Editing Network Settings
Change information for how your HP Media Vault connects to the network.

To edit network settings

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 Click the Network tab to view settings. Click Edit to make changes.
4 Make changes to the following network settings as necessary.

Workgroup name
The name of the Windows workgroup that all of your computers 
belong to. If you clicked Yes on the HP Media Vault Configuration 
dialog at the end of the software installation, the Workgroup name 
was entered for you. For additional information, see Installing the 
Software on page 1-8.
Set Secure HTTP
Remote access to shared folders or Webshare on the HP Media Vault 
is faster using HTTP. However, some Internet service providers require 
secure HTTP. If secure HTTP is enabled, you must type 
HTTPS:\\servername when accessing the Media Vault remotely.
Automatically assign IP settings (DHCP)
This is the default setting for the Media Vault. When this option is 
selected:
– The Media Vault automatically acquires its IP address and other 

settings from the DHCP (Dynamic Host Configuration Protocol) 
server on your network.
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– The values of the IP Address, Gateway server, Subnet Mask, Domain 
Extension, DNS servers, and WINS servers set by the DHCP server 
are displayed.

Manually assign IP settings
If you use a static IP address, you may want to manually configure the 
IP settings on the Media Vault. This should be done only by 
experienced network administrators.
IP Address
A number that uniquely identifies devices, such as computers, on a 
network.
Gateway
Type the IP address for the default gateway. This is the address of a 
local IP router on the same network as this computer that is used to 
forward traffic to destinations beyond the local network.
Subnet Mask
Identifies the portion of the network IP address that can be used for 
subnetworks.
Domain Ext
A domain extension is an optional part of a network name used to 
logically divide a large network into smaller networks.
DNS Server 1
The primary server that associates network names with IP addresses.
DNS Server 2
The alternate or secondary server that associates network names with 
IP addresses.

Note: Entering two DNS servers is recommended for stability.

WINS Server 1
WINS (Windows Internet Naming Service) is a server that converts 
NetBIOS network names to IP addresses.
WINS Server 2
WINS (Windows Internet Naming Service) is a server that converts 
NetBIOS network names to IP addresses.
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5 Click Save if you made changes to any of the settings.

Securing Your Media Vault from Intruders
The HP Media Vault is designed as an "always on" device, which comes in 
handy for accessing files any time your network users need or want them. But 
a network device that is set up for file sharing also presents certain security 
risks. Because the server can be used on a network that has both wireless and 
wired functionality, you'll want to ensure that unauthorized users can't access 
your server and your files stored on it.

If your network comes with wireless capability, it has a piece of equipment 
called a Wireless Access Point (WAP). A WAP can come within an all-in-one-
gateway, router, or as a standalone unit. In many cases, a WAP's security 
settings are toggled off by default and you must manually turn on the security 
settings. If the security settings are toggled off, anyone can get into your 
server as well as any computer or other devices on your network. Firewalls 
and anti-virus software do not keep intruders out of wireless networks.

Most wireless networking equipment supports two forms of data encryption as 
security features: Wired Equivalent Privacy or WEP and, Wi-Fi Protected 
Access or WPA. For more information on how to configure the security for 
your wireless network, see the user's guide that came with your networking 
equipment.

Anti-virus software

You should install anti-virus software on one or more computers on your 
network, and configure the software to scan all the shared folders on your 
server. You might be required to assign (map) drive letters to all your shared 
folders to enable the anti-virus software to scan the HP Media Vault.
Note: Remember to keep your anti-virus definitions up-to-date.

Establishing an administrator user name and password

Setting up an administrator user name and password is one way to 
safeguard your folders and files. If you do set up a user name and password, 
you are prompted to enter this information each time you enter the 
Configuration screens.

Important: It is strongly recommended that you create an administrator 
user name and password if you enable remote access.
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 For additional information, see Remote Access on page 9-99.

Securing the HP Media Vault’s shared folders on your LAN

The server offers additional security options for your network users and 
specific shared folders. For additional information, see Enhance Security on 
your Shared Folders on page 5-68.
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8 Streaming Media
What’s in this chapter
» Before You Begin Media Streaming
» Streaming Media to your Entertainment Center
» Setting up iTunes on the Media Vault and the Computer

Multiple computers in your home often means photos, music, videos and files 
are scattered all over the place and difficult to locate. The HP Media Vault 
provides a centralized location for all of your media files for easy access from 
any computer in your home. Additionally, if you have a Digital Media 
Adapter (DMA) attached to your television or stereo, you can stream media 
files from the server to your stereo or television.

Music

Consolidate your digital music in one location. It's as simple as dragging and 
dropping your music files into the Music folder on your HP Media Vault.

If you use iTunes, you can consolidate your iTunes libraries and playlists from 
multiple computers on your network to the Media Vault. 

Once music files are consolidated on the Media Vault, you can avoid 
unsightly cables and wirelessly stream music to your stereo if your DMA 
supports wireless media streaming.

Photos

Before owning an HP Media Vault, you probably stored most of your digital 
photos on your personal computer. This is great but you ideally want to show 
the photos on your large-screen TV so the entire family can gather around 
and see.

With the HP Media Vault, you can save your photos to your server once and 
watch them from any computer or DMA enabled TV in your home without 
creating copies, transferring files, burning DVDs, or rewiring cables.

Videos
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Store digital home movies and downloaded or digitally recorded movies and 
TV shows on your Media Vault. The large storage space enables you to store 
lots of shows before running out of storage space. The media streaming 
capabilities make it possible for you to store movies in one location and 
watch them on any DMA-enabled device in your home.

Before You Begin Media Streaming
There are a couple of things you need to do before you are ready to start 
media streaming.
• Media streaming looks for files of a certain type—photos, music, or 

videos—within the specified folder. Therefore, music must be placed in the 
music folder or a sub-folder of the music folder. Photos must be within the 
Photos folder. Videos must be in the Videos folder.
For example, if a .jpg (a photo file format) is placed in the music folder it 
will not be streamed as a photo. It is ignored since it is not in the photos 
folder.

• Make sure the shared folders are enabled for media streaming. For 
additional information, see Viewing Shared Folders on page 5-61 or 
Enabling Media Streaming for a Folder on page 8-95.

Streaming Media to your Entertainment Center
If you have a Digital Media Adapter (DMA) attached to your television and/
or stereo, you can play the media files stored on your server on these 
entertainment devices. The DMA accesses your stored media files and 
coordinates the streaming process between your server and the entertainment 
device. The Media Vault’s

 media server works with both wired or wireless DMAs. Your network must 
have wireless functionality to use a wireless DMA.

Two conditions are required for media streaming with the server:

1 Your DMA must use Universal Plug and Play (UPnP) A/V streaming.
2 Only media files are available for media streaming. The types of files that 

are considered "media" are: photographs, music (audio), and video. 
Non-media files, such as Microsoft Word documents, are not available 
for streaming.
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The following figure shows a possible layout for media streaming.

Figure 15: Media streaming layout

Enabling Media Streaming for a Folder
Streaming to DMA-enabled Devices. Enable media streaming if you 
have a Digital Media Adaptor (DMA) and want to stream photos, music, or 
videos in a folder to your television or stereo. Media streaming looks for files 
of a certain type—photos, music, or videos—within the specified folder. 
Therefore, music must be placed in the music folder or a sub-folder of the 
music folder. Photos must be within the Photos folder. Videos must be in the 
Videos folder.

For example, if a .jpg (a photo file format) is placed in the music folder it will 
not be streamed as a photo. It is ignored since it is not in the photos folder.

Streaming to iTunes. You can also enable media streaming if you are 
placing music files in a folder and want to listen to them using iTunes. Only 
music files that are not DRM-protected can be streamed to iTunes. Music 
purchased from the iTunes store or some other online stores cannot be 
streamed to iTunes from the Media Vault. Likewise, photos or videos cannot 
be streamed to iTunes, just music files.
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To enable media streaming for a folder

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 On the Shared Folders tab, click Edit next to the shared folder with 
media files that you want to stream.

4 Check Enable Media Streaming.
5 Click Save.

You are returned to the shared folders list and "Enabled" appears next to the 
folder. The shared folder and all of its subfolders are available for streaming.

Note: It can take a long period of time for files that you copy to a shared 
folder to appear on your DMA even if the shared folder has been enabled for 
media streaming.

Note: USB devices attached to the HP Media Vault have media streaming 
enabled automatically. If the USB device was formatted using the HP Media 
Vault Administration Console, you can enable or disable media streaming for 
the USB device.

Disabling Media Streaming for a Folder
Follow these steps if you want to turn off media streaming for a shared folder.

To disable media streaming for a folder

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 On the Shared Folders tab, click Edit next to the shared folder with 
media files that you want to disable from media streaming.

4 Clear Enable Media Streaming.
5 Click Save.
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You are returned to the shared folders list and "Disabled" appears next to the 
folder. The shared folder and all of its subfolders are disabled for streaming.
Note: USB devices attached to the HP Media Vault have media streaming 
enabled automatically. If the USB device was formatted using the HP Media 
Vault Administration Console, you can enable or disable media streaming for 
the USB device.

Resetting Media Streaming
The HP Media Vault’s media server scans your stored media files to gather 
information, such as artist names, song titles, video names, and so on, to 
create a database. The Reset Media Server button deletes this database 
and rebuilds it. (Your data is not deleted.) Resetting may take a long time 
depending on the number of multimedia files.

To reset media streaming

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 On the System tab, click Reset Media Server.

UPnP A/V Streaming
UPnP is a set of network protocols that allow networked devices to 
communicate seamlessly in a home networking environment. The UPnP A/V 
streaming method supports streaming of unprotected media files. Some files 
may be protected by a Digital Rights Management system, which may prevent 
the streaming of those files. Media files purchased and downloaded from an 
online Internet store are most likely protected.



Version 8-98

Setting up iTunes on the Media Vault and the Computer
The HP Media Vault provides the ability to copy your iTunes music library and 
playlists to the server. This feature allows you to centralize your iTunes library 
for playback on any computer or notebook running iTunes on your home 
network.

To setup copying your iTunes library to the server

The HP Media Vault is enabled for iTunes by default.

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Settings for iTunes.
3 In the Settings for iTunes page, set up the following:

Status—enable or disable.
Check interval—how often to check for music that has been added 
to the shared Music folder on the server.

4 Click Done to finish.
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9 Remote Access
What’s in this chapter
» Enabling Remote Access
» Renewing Your Personal Domain
» Accessing Your Media Vault Remotely
» Browsing Files Remotely

Remote access enables you to access photos, music, movies or other files on 
your HP Media Vault when you are away from home. For instance, you are at 
a party and have the ideal music on your server. You could log in remotely to 
download the music and burn it to a CD to share with all of your friends.

Likewise, remote access makes it possible for family and friends outside of 
your home network to access your HP Photo Webshare from a web browser. 
Family or friends outside of your home network can also view or upload 
photos or videos to Webshare once remote access is enabled and Webshare 
visitor accounts are created. For additional information on setting up 
Webshare, see Photo Webshare on page 3-33.

Enabling Remote Access
There are a few things to consider before enabling remote access. The first is 
the security of your HP Media Vault. It is strongly recommended that you 
create an administrator user name and password for your HP Media Vault 
Administration Console. Otherwise, anyone with your personal domain can 
access your Administration Console and change system settings for your 
Media Vault. For additional information, see Editing System Settings on 
page 2-26.

Another consideration before enabling remote access is the security level of 
your shared folders. Public shared folders must be password protected 
before they can be accessed remotely. Public shared folders have a lower 
level of security since they are password protected at the folder level. Private 
shared folders are more secure since they require each user to have a 
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password. For additional information, see Editing a Shared Folder on 
page 5-65.

This section guides you through:
• Creating a Personal Web Address
• Setting up your Router
• Testing Remote Access

Return to this page at any time to update information or troubleshoot remote 
access.

Creating a Personal Web Address
A personal web address is what you will use to access your HP Media Vault 
from a web browser. For instance, if you register MyFamily.hpshare.net as 
your personal web address, you will type this address in a web browser to 
remotely access your HP Media Vault.

To create a personal web address

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 Click the Remote Access tab.
Remote access is currently disabled.
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Figure 16: Remote Access home page before your personal web address is 
enabled.

4 Click Set up Web Address.
The Remote Access Setup|Web Address page opens.
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Figure 17: The Remote Access Setup|Web Address page.

5 Check Enable Web Address.
Checking this box gives remote users access to the HP Media Vault 
Administration Center that you are currently in and to the HP Photo 
Webshare.

Caution: To increase security on the HP Media Vault Administration Center, 
create an administrator password. See, Editing System Settings on page 2-26.

6 Create a Personal Domain.
Type a unique name for your personal domain and select a domain 
extension from the drop down list. The personal domain is free for one 
year.
A personal domain is a Web address. It allows you to access your HP 
Media Vault and HP Photo Webshare from the Internet. For instance, if 
you registered MyFamily.hpshare.net for your HP Media Vault, you 
would use this address to connect to your server using remote access. 
Additionally, this address is part of the URL for accessing an album on 
your Photo Webshare.

7 Type your First Name and Last Name.
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8 Type and confirm your Password.
9 Check Enable Internet File Browsing.

Check this box if you also want to be able to browse shared folders 
remotely.

10 Click Save.
The server connects to the Internet to check if your personal domain is 
available. If it is already in use, you are provided with alternate 
suggestions for your personal domain. Otherwise, you are returned to the 
Remote Access Setup page.

Setting up your Router
Setting up a personal web address is one requirement for enabling remote 
access. You also need to set up your router to pass remote access requests to 
your Media Vault. This is known as port forwarding.

To setup your router

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 Click the Remote Access tab.
If you already created a personal address, the Remote Access Setup page 
has several options enabled. If you do not see all of the options below, 
see Creating a Personal Web Address on page 9-100.
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Figure 18: The Remote Access Setup page after a personal web address is 
created.

4 Click Set up Router.
The Remote Access Setup|Router Configuration page displays.
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Figure 19: The Remote Access Setup|Router Configuration page.

5 Click Automatically Setup Router.
The HP Media Vault attempts to configure your router for port forwarding. 
A message displays letting you know if the Media Vault was successful at 
configuring your router or not.

6 If the Media Vault was not able to automatically configure your router, 
click Manually Set up Router.
The Manual Router Setup page displays with information that will be 
required to manually set up your router.
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Figure 20: The Manual Router Setup page.

7 Click Access your router.
The HP Media Vault attempts to open your router configuration page. The 
page that displays is unique to your router. If you have questions about 
configuring your router for port forwarding, see the documentation that 
came with the router.

8 Click Done on the HP Media Vault Remote Access Setup|Router 
Confirmation page when you are finished setting up your router.

Testing Remote Access
After you create a personal web address and set up your router for port 
forwarding, you are ready to test remote access.

To test remote access

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.
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3 Click the Remote Access tab.
You should see several options on this page if you created a personal 
web address and set up your router. If the only option you see is Set up 
Web Address, see Creating a Personal Web Address on page 9-100 for 
more information.

4 Click Get Directions.
The Remote Access|Testing Directions page displays.

Figure 21: The Remote Access|Testing Directions page.

5 Follow the instructions on the Remote Access|Testing Directions 
page.

6 Click Done.

Renewing Your Personal Domain
The first year you have a personal domain is free. There is a fee for each year 
after that. Complete the following steps to continue your subscription.
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To renew your personal domain

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 On the Remote Access tab, click Renew Personal Domain.
You are directed to the TZO website to renew your personal domain.

Accessing Your Media Vault Remotely
Remote access is a great way to get to photos, music, videos and other files 
on your server while you are away from home. Before you can use remote 
access, you must create a vanity URL or a personal URL and give users remote 
access permission.

To access your server remotely

1 Start any browser application.
Internet Explorer 7.0 or higher or Firefox 2.0 or higher are preferred.

2 Type your personal domain in the address box.
For instance, if you registered MyFamily.hpshare.net for your HP 
Media Vault, you would use this address to connect to your server using 
remote access. You are directed to the HP Media Vault home page.

3 Click an icon.
Configure—If you created an administrator name and password, 
type them when prompted. The HP Media Vault Administration 
Console opens for managing and configuring your HP Media Vault’s 
system settings. For additional information, see Editing System Settings 
on page 2-26.
Photo Webshare—Type your personal user name and password 
when prompted. The HP Photo Webshare opens. For additional 
information, see Editing a User on page 4-56. If the Photo 
Webshare Manager box is checked on your user account, you are 
set up as a Webshare Administrator and can see all of the Webshare 
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functionality. If this box is not checked, you have limited Webshare 
functionality.
If you are not a member of the home network, your user account was 
probably set up as a Webshare visitor. Type your personal user name 
and password to open Webshare. For additional information on 
Webshare visitor accounts, see To Create or Edit Visitors on page 3-
39. Contact your Webshare administrator if you have problems 
logging on.
Browse Files—You are prompted for a user name and password. If 
you are browsing public shared folders, type your personal user name 
and password. If you are browsing private shared folders, type the 
name of the private shared folder for the user name and the password 
for the folder. If you are using a combination of public and private 
shared folders, be careful to type the correct user name and password 
for the shared folders you want to browse. For additional information, 
see Editing a Shared Folder on page 5-65.

Browsing Files Remotely

Logging In
1 Open a browser and type your personal web address.

For instance, if you registered MyFamily.hpshare.net for your HP 
Media Vault, you would use this address to connect to your server using 
remote access. You are directed to the HP Media Vault home page.

2 Log in with your user name and password.
Private shared folders—Type your user name and password that were 
set up in the HP Media Vault. For additional information, see Creating 
a User on page 4-55 or Editing a User on page 4-56.
Public shared folders with passwords—Type the shared folder name as 
the user name and the shared folder password that was set up in the 
HP Media Vault. For additional information, see Creating a Shared 
Folder on page 5-63 or Editing a Shared Folder on page 5-65.
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Security
Shared folders that are configured for Public access and are not password 
protected are not available for remote file and folder browsing. Only shared 
folders that are set to Private access or Public access with a password are 
available for remote file and folder browsing. 

Browse Your Files and Folders
Click the name of the shared folder to browse the files on your HP Media 
Vault. 

The contents of the shared folder display on the right side of the screen if you 
have permission to access the shared folder. 

Download Files
Downloading a file sends the file from the HP Media Vault to the computer 
that you are browsing from. 

Click the file that you want to download. The file is highlighted and a small 
box with an arrow displays. Click the arrow to open the file menu. Select 
Download from the menu to start your download. You may continue to 
browse files and folders while you download a file.
Note: The HP Media Vault supports the following characters when 
uploading or downloading files remotely using a browser.

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
1234567890

You can upload and download files that contain other letters or special 
characters in the files names.  Those letters or characters are changed to 
squares during the upload or download process. Once the files are where 
you want them, you can open them or make changes.

If the files were uploaded to the Media Vault, you can rename them from a 
computer within your network using a method other than remote file 
browsing. For additional information, see Browsing Folders on page 6-75.

If the files were downloaded to your computer, you can rename them after the 
download completes.
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Upload Files
Uploading a file sends the file from the computer that you are browsing from 
to the HP Media Vault.

Click the folder where you want the uploaded file to be stored. The folder is 
highlighted and a small box with an arrow displays. Click the arrow to open 
the folder menu. Select Upload from the menu. A file selection window 
appears. Use the Browse button to select the file to upload. After you select 
your file and click Upload File your upload begins. You may continue to 
browse files and folders while you upload a file. The upload window informs 
you when the file transfer is complete. 
Note: The HP Media Vault supports the following characters when 
uploading or downloading files remotely using a browser.

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
1234567890

You can upload and download files that contain other letters or special 
characters in the files names.  Those letters or characters are changed to 
squares during the upload or download process. Once the files are where 
you want them, you can open them or make changes.

If the files were uploaded to the Media Vault, you can rename them from a 
computer within your network using a method other than remote file 
browsing. For additional information, see Browsing Folders on page 6-75.
If the files were downloaded to your computer, you can rename them after the 
download completes.

Logging Out
When you are done browsing files and folders on your HP Media Vault, you 
can log out by clicking on the red X in the upper right-hand corner.

If you want to browse a different shared folder that is set to Public access 
mode (with a password), you will need to log out, and log back in using the 
desired shared folder name as the user name. 
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10 Managing Storage Space
What’s in this chapter
» Viewing Disk Settings
» Adding an Internal Hard Drive
» Removing an Internal Hard Drive
» Creating Mirrored Disks
» Adding and Removing an External USB Device
» Formatting an External USB Device
» Replacing the system drive

You can expand storage in the HP Media Vault in a couple of ways:
• Add a Serial ATA (SATA) hard drive to the Media Vault’s internal 

expansion bay (Integrated Drive Electronics (IDE) drives are not 
supported.). Use this option to add permanent storage space to your 
Media Vault.

• Add up to two USB disk drives to the Media Vault’s USB ports. Use this 
option to back up to an external storage device or to add temporary 
storage space to your Media Vault.

Viewing Disk Settings
Displays information for internal and USB disks.

To open the disk settings tab

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 Click the Disks tab.
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To view internal disk information
• Refresh

Click Refresh to update the information on this page without changing 
tabs. Clicking the browser’s refresh button returns you to the Status tab.

• Disk Name
The name of the internal disk.

• Unavailable
No disk is detected in the expansion slot.

• Actions
Add
You must tell the Media Vault how you want new storage space 
allocated. When you click Add, you have the option to increase your 
storage space or to make the storage redundant or mirrored.
Safely Remove
Click Safely Remove prior to physically removing an internal or 
external disk.

• Type
Mirrored
A mirrored share automatically stores an exact copy of files on a 
second hard drive. Using a mirrored share reduces the chance of you 
losing critical files if one hard drive fails.
Non-Mirrored
A non-mirrored share is stored on a single hard drive. The HP Media 
Vault does not automatically maintain a copy of these files on a 
second hard drive. If a non-mirrored drive fails, the files stored on it 
are lost.

• Status
Healthy
The drive is functioning properly.
Building
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After an internal mirrored disk is added, it must create the redundant 
files. The building status indicates that this is taking place. The percent 
complete and estimated time are provided.
Degraded
The degraded status only applies to mirrored drives. It indicates that 
one drive failed. The system is operational, but the files stored on the 
HP Media Vault are no longer redundant. The light bar for the failed 
drive on the HP Media Vault box is red. For additional information on 
replacing the failed drive, see Removing an Internal Hard Drive on 
page 10-122 and Adding an Internal Hard Drive on page 10-116.
Failed
The failed status only applies to non-mirrored drives. It indicates that 
one drive failed. The system is not operational until the drive is 
replaced. The light bar for the failed drive on the HP Media Vault is 
red. For additional information on replacing the failed drive, see 
Removing an Internal Hard Drive on page 10-122 and Adding an 
Internal Hard Drive on page 10-116.

• Size
The total storage space on the disk.

• Free
The amount of space available on the disk.

To view USB disk information
• Disk Name

The name of the USB disk. You can change the name when you format 
the disk.

• Actions
Format
Deletes all data from the USB disk and prepares it for use in the Media 
Vault.
Remove
Click Remove prior to physically removing a USB disk.

• Format
Linux (ext3)
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This option formats the disk into a proprietary Linux file system (ext3). 
Formatting the disk using this file system does not allow the disk to be 
disconnected from the Media Vault and used on another computer. 
The disk will be dedicated for permanent use on the Media Vault. This 
format is suggested for best performance.
Windows (FAT32)
This option formats the disk using the FAT32 file system. Formatting the 
disk using this file system enables you to disconnect the hard drive 
from the Media Vault and use it on another computer.

• Status - Healthy
The drive is functioning properly.

• Size
The total storage space on the disk.

• Free
The amount of space available on the disk.

Adding an Internal Hard Drive
The HP Media Vault’s primary system hard disk uses the Serial ATA (SATA) 
interface. The internal expansion bay accommodates a second SATA disk. 
(The server does not support adding Integrated Drive Electronics (IDE) disks.)
Note: You should not remove or add a hard disk to the server while it is 
powered on and running.

To add a hard drive to an expansion bay

1 Press the power button on the back of the Media Vault for about five 
seconds and release it to turn off the server.

2 Open the door on the front of the Media Vault.
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Figure 22: Opening the door

3 Press the lever to unlock the handle.

Figure 23: Unlocking the hard-drive tray

4 Lift the handle all the way up.

Figure 24: Lifting the handle

5 Gently pull the hard-drive tray from the expansion bay.
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Figure 25: Removing the hard-drive tray

6 Fold down the flap near the back of the hard-drive tray.

Figure 26: Folding down the flap

Note: This flap improves air flow through the server. If you remove a 
drive, be sure to fold this flap back up.

7 Insert the new drive into the left side of the hard-drive tray, making sure 
that the pins go into the hard drive’s mounting holes.
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Figure 27: Putting the new drive in the hard-drive tray—left side

8 Flex the right side-rail, and then insert the pins into the hard drive’s 
mounting holes.

Figure 28: Putting the new drive in the hard-drive tray—right side

9 With the handle up, slide the hard-drive tray and drive into the expansion 
bay.
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Figure 29: Inserting the drive tray into the expansion bay

10 Press down on the handle on the hard-drive tray until it locks.

Figure 30: Closing the handle

11 Close the door on the front of the server.

Figure 31: Closing the door

12 Press the power button on the back of the Media Vault to turn it on.
13 Notice that within a few seconds the light-bar for the new hard drive turns 

purple .
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This indicates that the hard drive has been installed, but has not been 
initialized.

To add a hard drive to total storage

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 On the Disks tab, locate the internal disk you want to add.
4 Click Add.
5 Select an option for allocating the disk space.

Caution: It is important to select the storage space allocation option with 
care. Changing how the storage space is allocated later may require you to 
transfer all of the files to a separate device and reformat the drives.

Allocate disk to make current storage mirrored (protects 
current storage, RAID 1) - adds the internal drive as mirrored 
storage space.
The type of mirroring supported on the Media Vault is called 
Redundant Array of Independent Disks (RAID) RAID-1.
In RAID-1 mirroring, an identical copy of data written to one hard disk 
is written to a second hard disk. Mirroring disks reduces your total 
hard disk storage capacity by half. The advantage is that if one hard 
disk fails, you have a copy of your data on the second hard disk.
Allocate disk to expand current storage (increases current 
storage) - combines the available space from the system drive and 
the internal hard drive to make one large logical disk. The drive space 
is not mirrored. If a non-mirrored drive fails, the files stored on the 
failed drive are lost. If a drive is removed from the HP Media Vault, the 
system is not operational until the drive is replaced.

6 Click Accept.
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Removing an Internal Hard Drive
Hard drives can be removed from the HP Media Vault. However, hot 
swapping is not supported. The Media Vault must be powered down prior to 
removing the drive.

To remove a hard drive from total storage

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 On the Disks tab, locate the internal disk you want to remove.
4 Click Safely Remove.

When the server is ready, you receive a message telling you that it’s okay 
to remove the drive from the server.

5 Click OK.
6 Be sure that the light-bar for the hard drive is purple . This 

indicates that the drive has been properly removed from the server’s total 
storage.

7 Power down the server by pressing the power button on the back of the 
server and wait until it completely shuts off.

Note: Removing non-mirrored hard disks can cause undesirable behaviors. 
In a non-mirrored system, files may span multiple disks and removing one disk 
makes the entire HP Media Vault non-operational (at least until the disk is 
reconnected). If you remove a non-mirrored disk and change your mind, 
replace the drive. Click Fix under the disks Actions to add the drive back to 
the total storage space.



10-

To remove a hard drive from an expansion bay

1 Open the door on the front of the HP Media Vault.

Figure 32: Opening the door

2 Press the lever to unlock the handle.

Figure 33: Unlocking the hard-drive tray

3 Lift the handle of the hard-drive tray all the way up.
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Figure 34: Lifting the handle

4 Gently pull the hard-drive tray from the expansion bay.

Figure 35: Removing the system-drive tray

5 Flex the back of the right side-rail, and then withdraw the back pin from 
the hard drive by gently pulling the side-rail down and away.

Figure 36: Removing the right side-rail

6 Flex the front of the right side-rail, and then withdraw the front pin from 
the hard drive by gently pulling the side-rail down and away.

7 Remove the drive from the hard-drive tray.
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Figure 37: Removing the drive

8 Fold up the flap near the back of the hard-drive tray.

Figure 38: Folding up the flap

Note: Folding up the flap improves air flow and helps keep the server 
cool.

9 With the handle up, slide the hard-drive tray back into the system bay.
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Figure 39: Inserting the hard-drive tray into the system bay

10 Close the handle on the hard-drive tray until it locks.

Figure 40: Closing the handle

11 Close the door on the front of the server.

Figure 41: Closing the door

Creating Mirrored Disks
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This option creates a mirror or duplication of an existing disk on the HP 
Media Vault.

When you save files to a mirrored disk, your files are saved to both hard 
disks. The end result is that half the total amount of space is available to store 
your files. For example, two 200GB drives mirrored together result in total 
storage space of 200GB, not 400GB.
Note: When creating a mirror, you must use a blank hard disk that is the 
same size or larger than the source disk you want to mirror.
Data on a mirrored disk is safe unless both disks fail at the same time. If one 
hard disk fails, the server administers a warning. The failed hard disk should 
be replaced immediately.

To create a mirror

You must insert a new internal disk that is the same size or larger than the 
existing disk into your HP Media Vault prior to completing this procedure.

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 On the Disks tab, locate the disk you want to mirror.
4 Click Add.

A message displays giving you the option to expand the current storage 
space or to make the storage space redundant.

5 Click Allocate disk to make current storage mirrored 
(protects current storage, RAID 1).

6 Click Accept.
This process may take several hours before the disk is completely 
mirrored. You can continue to use the server during this time.
Note: If the expansion disk does not have enough space, the option to 
create a mirror is grayed out.
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Note: The server does not automatically show the progress of the 
mirroring. To view the progress, click Refresh. The progress status is 
indicated under Status on the Disk Settings page.

Adding and Removing an External USB Device
You can add external USB disks to either of the HP Media Vault’s two USB 
ports (one on the back and one on the front). Small USB disks, such as key 
disks and jump drives, can also be attached. Portable devices, such as 
cameras and phones, can be attached if your system detects those devices as 
USB storage devices. If you have any questions, check with the USB 
manufacturer to verify that the device is classified as a USB storage device.

The contents of the USB device are made available for media streaming once 
the device is plugged into the Media Vault.

To connect an external USB drive

Plug the USB device into one of the USB ports on your server. If you have 
questions, see the documentation that came with your USB device. If you use 
a USB disk drive, it is recommended that you use a drive that conforms to USB 
2.0 or later.

A shared folder is automatically created for the USB device when it is 
plugged into the USB port. For additional information, see Browsing Folders 
on page 6-75. Additionally, the USB device contents are available for media 
streaming. For additional information, see Streaming Media on page 8-93.
Note: The addition of multiple USB devices through an external USB hub is 
neither recommended nor supported.

To add the USB drive to total storage

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 Click the Disks tab.
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The USB device is listed under USB Disks. Additionally, any folders on 
the USB device are automatically shared and available for media 
streaming.

To remove a USB drive from total storage

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 On the Disks tab, locate the USB device you want to remove.
4 Click Remove.

The drive is removed from the list of drives on the Disk Setting page. 
Disconnect the USB device from the server.

Formatting an External USB Device
The HP Media Vault can interact with USB devices formatted as FAT32, NTFS, 
or ext3. The HP Media Vault can read and write files to FAT32 and ext3. The 
Media Vault can only read files from NTFS devices. It cannot write to them.

You may also want to consider that ext3 disks can store larger files, over 74.7 
GB.

To format a USB device
Note: Formatting disk drives erases all the disk’s contents, including boot 
records, partition tables, and all shared folders and their sub-folders and files. 
Format disks only when you know that it is safe to proceed.

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 On the Disks tab, locate the USB disk you want to format.
4 Click Format.
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5 Enter the disk’s name in the Disk Name box.
6 Select one of the following format types

Linux (ext3) - The HP Media Vault comes with a primary hard disk 
called SYSTEM. The SYSTEM disk is formatted into a proprietary Linux 
file system (ext3). The format of the SYSTEM disk does not change.
Formatting a second internal hard disk into the proprietary Linux file 
system gives you the best read/write performance. However, a Linux-
formatted hard disk on the server cannot be disconnected and used in 
a different computer. You can only read and write data to the server’s 
hard drive when its connected to the server.
Windows (FAT32) - The FAT32 file system allows you to read and 
write to the hard disk. Microsoft used this file system for Windows 
versions 95, 98, 98SE, ME, 2000, and XP. Files on FAT32 disks 
cannot be larger than 4 GB. If you format a server hard disk in FAT32, 
you can disconnect the disk and use it on Windows, Macintosh and 
Linux computers. However, you cannot store files larger than 4GB on 
FAT32 file systems.

7 Click Accept.

Replacing the System Drive
Replacing the internal system drive consists of three parts:

1 Removing the system drive on page 10-131
2 Re-installing the new system drive on page 10-133
3 Resetting the System.
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Removing the system drive
The system drive is located below the removable drive tray.

Figure 42: Location of internal system drive

To remove the system drive

1 Press the Power button momentarily to shut down the Media Vault.
2 Open the door on the front of the Media Vault.

Figure 43: Opening the door

3 Remove the top expansion drive tray.
See, To remove a hard drive from an expansion bay on page 10-123 for 
additional information.

4 Remove the four screws holding the system plate.
5 Remove the system plate from the front of the Media Vault.
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Figure 44: Removing the system plate

6 Gently pull the system drive from the Media Vault.

Figure 45: Removing the system drive

7 Remove the four screws from the sides of the system drive.
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Figure 46: Removing the screws from the system drive

Re-installing the new system drive
This topic provides information about how to install the system drive.

To re-install the new system drive

1 Insert the four screws from the Media Vault system drive into the sides of 
the new drive.

Figure 47: Putting the screws into the sides of the system drive

2 Slide the drive into the system bay.
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Figure 48: Inserting the new drive into the system bay

3 Replace the system plate on the front of the Media Vault.

Figure 49: Replacing the system plate

4 Replace the four screws in the system plate.
5 Replace the top expansion drive tray.

See, To add a hard drive to an expansion bay on page 10-116 for 
additional information.

6 Close the door on the front of the server.
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Figure 50: Closing the door

7 Power on the Media Vault.
8 Perform a Factory Reset to initiate the drive.
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11 Back up and Restore
What’s in this chapter
» Backing up Important Files on this Computer
» Backing up an Entire Hard Drive (on HP Media Vault Pro models only)
» Restoring a Drive Backup (on HP Media Vault Pro models only)
» Backing up the HP Media Vault to a USB Device
» Backing up Files and Folders to an Online Service

Backing up Important Files on this Computer
Your HP Media Vault is bundled with NTI Shadow software. NTI Shadow is 
an easy-to-use application that lets you run automatic backups for the 
important files and folders on your computer. You can back up any data you 
want, including photo, music, video, and financial files. Using NTI Shadow 
does not disturb your computer use because it works transparently in the 
background.

NTI Shadow offers two ways to back up folders on your computer.
• Simple Backup—Select this option to backup selected folders and their 

sub-folders on this computer every time you make change to their 
contents.

• Custom Backup—Select this option if you want greater control over the 
folders or files that you backup. Likewise, you can choose to backup your 
selections every time they change or schedule a specific time for backups.

If you want to back up an entire drive, see Backing up an Entire Hard Drive 
(on HP Media Vault Pro models only) on page 11-142.

This help topic has steps:
• To perform a simple backup
• To create a custom backup
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• To modify a custom backup

To perform a simple backup

A simple backup backs up only the My Desktop, My Pictures, My Music, My 
Videos, and My Documents folders that are installed by Windows for each 
User Account on this computer.

After configuring Simple Backup, each file is backed up every time you make 
a change to the file.

Additionally, Simple Backup creates one version of each file and places that 
file in a directory called Revision.

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Backup tab, click Back up Important Files.
The Simple Backup tab should be selected.

3 Select one or more of the following folders:
Note: Only the following folders and their sub-folders are backed up.

My Documents
The default folder for documents, graphics, and other personal files. 
Many programs automatically save data files to this folder.
– My Music
The default folder for audio files, such as those you download from the 
Internet or save on your hard drive.
– My Pictures
The default folder for photographs. Many digital-camera and photo-
editing software programs automatically create a sub-folder in this 
folder to which they save their pictures.
– My Videos
The default folder for video clips, such as those you download from the 
Internet or saved on your hard drive.
My Desktop
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All files and folders on the Desktop are backed up, including shortcuts. 
Note that backing up a shortcut does not backup the program that the 
shortcut opens.

Note: Any file stored in one of the above folders is backed up 
regardless of its type. For example, a document file stored in My Music is 
backed up.

4 Click Start.
The backup process starts. Your first back up could take some time, 
depending on the amount of data. The selected folders are backed up 
and copied to \\HPMediaVault\Backup.
Note: If you need more backup capability, see Run automatic backups 
for important files.

To create a custom backup

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Backup tab, click Back up Important Files.
3 Click the Custom Backup tab.
4 Click Create Backup Job.
5 Select the folders or files to back up.

To back up an entire folder:
In the Backup job wizard, click the check box next to the folder that 
you want to back up. A blue check box next to the folder indicates that 
you have selected to backup the entire contents of that folder.
To back up specific files:
– In the left pane, select the folder that contains the files you want to 

back up. Selecting a folder opens the folder and displays its 
contents in the right pane.

– In the right pane, select the files you want to back up.
– To select a file or folder, click its associated check box.
Note: If you add any new files to a folder that has a gray check box 
next to it, these files are not included in future automatic backups.

6 Click Options to backup files of a specific type.
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NTI Shadow backs up all file types unless you specify that you want to 
back up only specific kinds of files for backup. For example, you can 
specify that only the audio files in a folder are backed up.
a Check a file type or type a custom file type.
b Select to either include or exclude all of the selected file types from the 

backup.
c Click OK to return to the Backup Job Wizard.

7 Click Next.
8 Browse or type your Backup Destination.
9 Schedule your backup using one of the following options:

Save your folder/file to the HP Media Vault every time you save 
changes to your computer

Save your folder/file changes every
Use the drop-down lists to select the time interval for your backup in 
Minutes, Hours, or Days.
Save your folder/file changes every
– Select one or more check boxes for the days you want to schedule 

your backups.
– Select the Hours, Minutes, and AM or PM.
Note: If you select a fixed schedule (specific day or time), to ensure 
optimum performance, choose a different time for each computer to 
back up its files. This avoids multiple backups to the server at the 
same time.

10 Click Next.
11 Select the number of previous file versions to save:

Save all the previous file versions
Selecting this option backs up each version of your files. This options 
keeps all previous versions of your files
Save a limited number of previous file versions
Selecting this option backs up the number you specify in the list box up 
to nine versions.
Do not save any previous file version
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Selecting this option stores only the latest version of the files.
Option button
Allows you to delete the backup files/folders from your server when 
you delete the file from your computer. Select Delete the file on the HP 
Media Vault when the file is deleted on your computer, and then click 
OK.

12 Click Next.
13 Type a Job Name.

NTI Shadow automatically names the file based on the computer name, 
date, and time. You can rename the backup if desired. You should use a 
unique name to identify the backup.

14 Check if you want to Show progress bar.
15 Click Finish.

The Start Backup dialog box appears asking whether you want to start 
the backup now. The selected files and folders are backed up and copied 
to \\HPMediaVault\Backup.

Select Yes to start the backup immediately.
Select No to save the backup. If you chose this option, the backup 
with start as scheduled or you can start the backup in the Modify 
Backup Job pane (see Modify a backup job).

Note: The NTI Shadow icon is displayed in the computer Task Bar 
whenever a backup job is configured.

To modify a custom backup

Your HP Media Vault is bundled with NTI Shadow software. NTI Shadow is 
an easy-to-use application that lets you modify any backup jobs you have 
previously created. You can change the settings of the job, enable or disable 
jobs, and delete jobs. (For information about creating a backup, see Run 
automatic backups for important folders or files.)

The Modify Backup Job list box shows the list of backup jobs that have been 
created. The list includes the name of the backup job, the last time the job 
ran, which folder/files were backed up, and the location of the backup 
folders.
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1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Backup tab, click Back up Important Files.
3 Click the Custom Backup tab.
4 You can modify a backup as follows:

Edit
Opens the Backup job wizard, where you can modify the backup as 
described in Run automatic backups for important folders or files.
Disable/Enable
Disables or enables the selected backup job. A disabled backup is not 
run until it is re-enabled.
Disable All
Disables all backup jobs.
Delete
Deletes the selected backup job.
Start Backup
Immediately starts the selected backup. The backup must be enabled 
to start.

5 You can also view the log file:
View Log File
Displays information about the backup process.
Done
Closes the NTI Shadow screen. If a backup is running, it continues to 
run. Changes to the enabling or disabling of any backup jobs are 
saved.

6 Click Done.

Backing up an Entire Hard Drive (on HP Media Vault Pro 
models only)

Your HP Media Vault Pro is bundled with NTI DriveBackup!. NTI DriveBackup! 
is an easy-to-use application that lets you backup an entire disk drive or drive 
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partition on your computer to ensure that all your data and programs are 
protected against disaster.
Note: You can also use DriveBackup! to restore a previous drive backup to 
your disk drive. 

For more information, see Restoring a Drive Backup (on HP Media Vault Pro 
models only) on page 11-146.

This help topic describes:
• Creating a Drive Backup
• DriveBackup! Menus
• NTI Schedule Viewer

Creating a Drive Backup
1 At the computer, click Start, All Programs, HP Media Vault, and 

then Control Center.
2 On the Backup tab, click Back up Entire Hard Drive.
3 Select Drive to Backup from the drop-down list.

Note: Note the amount of used space shown in this step and make sure 
that your media vault has enough storage capacity for the backup.

4 Browse or type the destination for your backup.
5 Type a backup name.

NTI DriveBackup! automatically names the backup file using the computer 
name, date, and time. You can rename the backup if desired. You should 
use a unique name to identify the backup.

6 Click Options and select the desired backup options:
General Tab
– Compression
Selecting this option enables NTI DriveBackup! to reduce the size of 
the backup. The size reduction depends on the kind of data being 
compressed. Some kinds of audio and a video files are already 
compressed; subsequently, further compression is negligible.
– Verify
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If you select this option, NTI DriveBackup! performs a verification step 
to ensure that the correct files exist on the backup.
– Play a sound when the backup completes.
Password Tab
– Check Enable Password Protection to turn on this feature.
– Type and confirm the password.
Click OK to return to the HP Media Vault - NTI Drive Backup 
dialog.

7 Click Schedule to schedule your backup for a specific time.
Note: When selecting a schedule, to ensure optimum performance, 
choose a different time for each computer to back up its files. This avoids 
multiple backups to the media vault at the same time.

a In the Scheduler Setup dialog, select the frequency of the backup: 
Once, Weekly, Monthly, or Daily.

b If you select Daily, you can specify the particular days of the week 
you want the backup to occur.
– Click Which Days.
– Select one or more days of the week, and then click OK.

c The Start at group changes according to the frequency you 
previously selected. Select the time for the backup as follows:
– Once
Select the time, month, day, and year. For example: 12:00 AM, 
January, 20, 2007.
– Weekly
Select the time and day of the week. For example: 15:15, Sunday.
– Monthly
Select the time and day of the month. For example: 10:30 PM, 1. 
Because not every month has 31 days, we suggest that you use the first 
day of the month for monthly backups.
– Daily
Select the time of day. For example: 21:33.
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Note: To set the hour and minute of the time option, you can select 
each column (Hours, Minutes, and AM or PM (for the 12-hour clock 
format), and then either enter the time or use the Up and Down 
arrows.

d Click OK to return to the HP Media Vault - NTI Drive Backup 
dialog.

8 Click Start to immediately begin the backup.
The Create Drive Image Backup screen appears. This screen shows the 
details and progress of the backup process.

9 After the backup finishes, you can do the following:
To view a report of the backup, click View Report.
To close the Create Drive Image Backup screen, click Close.

DriveBackup! Menus
The DriveBackup! menus provide additional functionality for backing up your 
drive or drive partition.
• Job Menu

Provides the following standard file capabilities: New, Open, Save, Save 
As, Exit.

• Options Menu
Sets password protection as described in Password button above.

• Reports Menu
Allows you to view or delete reports of all backup and restore operations. 
Every time a backup is created or restored, DriveBackup! creates a report 
file that contains information to help you to trace and diagnose problems 
that might occur. DriveBackup! will report all errors that have occurred in 
backup or restore process in these files.

View Backup Reports
Opens the Backup Report dialog box where you can View or Remove 
reports by highlighting the report and selecting the appropriate button.
View Restore Reports
Opens the Restore Report dialog box where you can View or Remove 
reports by highlighting the report and selecting the appropriate button.
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• Help Menu
Provides the built-in NTI help and support.

NTI Schedule Viewer
The NTI Schedule Viewer is a backup monitoring program that you can use to 
delete, suspend, or resume already scheduled NTI DriveBackup! jobs.

To access the NTI Schedule Viewer:

Click Start, All Programs, NTI DriveBackup! 4, and NTI Schedule 
Viewer.

All scheduled backup jobs can be viewed from the NTI Schedule Viewer 
window.

To delete a scheduled backup job:

1 In the NTI Schedule Viewer window, right-click the job you wish to delete, 
then click the Delete job.

2 In the confirmation dialog box, click Yes.

To suspend or resume a job:

1 In the NTI Schedule Viewer window, right-click the backup job you wish to 
suspend or resume. A context window appears.
Within the context window, a check mark next to Suspend job indicates 
that the job is suspended. If no check mark is visible, the job will be 
processed normally.

2 Click Suspend job to suspend or resume a job.

Restoring a Drive Backup (on HP Media Vault Pro 
models only)

Your HP Media Vault is bundled with NTI DriveBackup!. NTI DriveBackup! is 
an easy-to-use application lets you restore an entire disk drive or drive 
partition on your PC that you have previously backed up using NTI 
DriveBackup!. (For information about creating a backup, see Backing up an 
Entire Hard Drive (on HP Media Vault Pro models only) on page 11-142.)
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If you wish to restore the system drive, you must use the PC Restore Disc. A 
system drive cannot be restored from the Windows operating system because 
it would have to write over itself.

About restoring a drive backup
Note: When restoring a disk drive, any content that exists on the target hard 
drive or drive partition will be erased.

• Restored NTFS partitions cause the Windows chkdsk utility to run when 
the system is rebooted. This utility creates and displays a status report for 
a disk based on the file system. Windows 2000 SP4 or Windows XP will 
run the verification process and then restart. The restored drive should be 
fully operational after the computer restarts.

• You cannot select a partition that is smaller than the amount of data on 
the original partition. However, you may select a larger partition. In some 
cases, you may need to select a target partition that is the same size as 
the original partition.

• When you select a drive to restore, you must pay attention to the 
compatibility of the file systems between the source backup and the target 
drive. The following table lists all compatible combinations of source and 
target file systems and the resulting partition format.

To restore a drive backup, follow these steps:

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Backup tab, click Back up Entire Hard Drive.

Table 4: Compatible Combinations

Source Partition Target Partition Resulting Partition

NTFS NTFS NTFS

NTFS FAT 16 NTFS

NTFS FAT 32 NTFS

Any other combinations are not supported.
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3 In Step 1, select the location of the backup file you want to restore from 
the drop down list or browse to its location.

4 In Step 2, select the hard drive you want to restore from the drop down 
list.

5 Click Start.
The time it takes to restore the drive or drive partition depends on the size 
of the backup file.

DriveBackup! Menus
The DriveBackup! menus provide additional functionality for backing up your 
drive or drive partition.
• Job Menu

This menu provides the following standard file capabilities: New, Open, 
Save, Save As, Exit.

• Options Menu
Sets password protection.

• Reports Menu
Allows you to view or delete reports of all backup and restore operations. 
Every time a backup is created or restored, DriveBackup! creates a report 
file that contains information to help you to trace and diagnose problems 
that might occur. DriveBackup! will report all errors that have occurred in 
backup or restore process in these files. By default, all report files are 
located in the Report Files directory found in the installation directory for 
your DriveBackup! software.

View Backup Reports
Opens the Backup Report dialog box where you can view or remove 
reports by highlighting the report and selecting the appropriate button.
View Restore Reports
Opens the Restore Report dialog box where you can view or remove 
reports by highlighting the report and selecting the appropriate button.

• Help Menu
Provides the built-in NTI help and support.
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NTI Image Explorer
The NTI Image Explore allows you to restore individual folders and files from 
a DriveBackup! file. DriveBackup! files have an .npf extension. To restore an 
entire drive or partition, see Restore a drive backup.

To restore individual folders or files from an .npf file, follow 
these steps:

1 Start NTI Image Explorer:
a Click Start, All Programs, NTI DriveBackup! 4, and NTI 

Image Explorer.
b In the EasySteps 1: What to restore? screen, select the location 

of the backup file you want to restore from the drop-down list.
c Click Browse to find and select the particular backup file you want to 

restore.
The selected file appears in the box below the list box and Browse 
button. The backup files contained in the DriveBackup! file appear in 
the selection panes in the bottom part of the screen.

d In the left pane, navigate to the folder that contains the files that you 
want to restore. (The selection of folders and files is identical to that 
described in Run automatic backups for important files.)

e In the right pane, select the folder or files that you want to restore.
2 Click EasySteps 2.
3 Select one of the following options to restore the files:

To restore the files to their original location, select Original.
To restore the files to a different location, select Other and then 
Browse.

4 Click EasySteps 3.
5 Select the overwrite options of the restore:

Never replace a file with its backup copy
Replace a file only if its backup copy has a newer file 
date and time
Always replace a file with its backup copy

6 Click Start.
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7 In the Operation Finished dialog box, click Close; or if you want to 
view a report of the restore, click View Report.

Backing up the HP Media Vault to a USB Device
Creating backups of your files ensures you have a copy that can be restored 
to your HP Media Vault if you experience accidental deletions or mechanical 
failures.

To back up shared folders

1 Plug a USB device into the HP Media Vault.
For additional information, see Adding and Removing an External USB 
Device on page 10-128.

2 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

3 On the Backup tab, click Backup HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

4 Check the Shared Folder Names to back up.
The following default shared folders are listed. If you created others, they 
are also listed. As you check folders, their total space required for backup 
is calculated.

Backup
Location of files backed up by PC Backup software.
Documents
The pre-configured folder that you can use for documents, graphics, 
and other personal files.
Music
The pre-configured folder that you can use for audio files, such as 
those you download from the Internet or save on your hard drive.
Photos
The pre-configured folder that you can use for photographs. Many 
digital-camera and photo-editing software programs automatically 
create a sub-folder in this folder to which they save their pictures.
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Videos
The pre-configured folder that you can use for video clips, such as 
those you download from the Internet or save on your hard drive.

Note: Any file stored in one of the above folders is backed up 
regardless of its type. For example, a document file stored in Music is 
backed up.

5 Select destination USB device.

Important: The USB device will be reformatted when you click Start 
Backup. All files currently on the USB device will be deleted.

6 Click Start Backup.
Your backup is named “(date stamp)_backup.”

Note: Click Refresh to update the information on this page without 
changing tabs. Clicking the browser’s refresh button returns you to the Status 
tab.

Private shared folders that are backed up to the USB device will not 
request a password for validation when they are accessed on the USB 
device. For this reason, it is recommended that you disconnect the USB 
device from the HP Media Vault after the backup is complete.

Backing up Files and Folders to an Online Service
Backing up files and folders and storing them at an off site location is 
recommended for critical data. Purchasing Spare Backup, enables you to 
backup files and folders to a remote location via an online service.

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Backup tab, click Online Backup.
A web browser opens to the Spare Backup web site.

3 Follow the instructions on the screen for purchasing Spare Backup.
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12 Troubleshooting
What’s in this chapter
» HP Media Vault Troubleshooting tips on page 12-153
» Network connection troubleshooting tips on page 12-163
» Webshare troubleshooting tips on page 12-169
» iTunes troubleshooting tips on page 12-174
» Email Troubleshooting tips on page 12-175
» Media Streaming Troubleshooting tips on page 12-176

HP Media Vault Troubleshooting Tips
In this section we will cover:

Your network cannot find the HP Media Vault on page 12-153

You receive Microsoft Vista permission messages on page 12-155

Restoring a Mirrored Volume on page 12-155

Power-on indicator is off on page 12-156

What to do if the HP Media Vault is unresponsive on page 12-156

Why is the hard drive light-bar purple? on page 12-157

Why is the hard drive light-bar red? on page 12-157

Why does my HP Media Vault shut down by itself? on page 12-158

Computer Recovery (this option is only available on the HP Media Vault Pro) 
on page 12-158

Router on page 12-158

My HP Media Vault loses its router settings on page 12-159

What are the minimum browser requirement needed by the online User's 
Guide? on page 12-161

Your Network Cannot find the HP Media Vault
Try the following procedures to connect the HP Media Vault.
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Check all cords, cables, and outlets

1 Make sure all devices on your network are correctly installed and the 
cables are connected to the proper ports.

2 Make sure you press in the power button.
3 Make sure your router has power.
4 Restart your router (or unplug and plug it back in).
5 Restart all the devices on your network, including your computers and the 

HP Media Vault.
6 If you’re using your own Ethernet cable, try using the Ethernet cable that 

came with the HP Media Vault.

Check the LED lights on the front of the HP Media Vault
• The Power Indicator LED  light should be blue.
• The Health Indicator LED  should blue.
• The Network Activity Indicator LED  should blue.

Ensure that you have connected the HP Media Vault to the 
correct network adapter
Do you have multiple network adapters connected to different physical 
networks? If so, enable the network adapter on the network that you have 
attached the HP Media Vault, and disable the other network adapters. You 

Table 5: Health Code Indicators

Code Action

1-blue (short), 1-red (long) Boot image missing Run firmware repair utility on 
PC

1-blue (short), 2-red (long) Failed Recovery Restart the HP Media Vault and 
run firmware repair utility on 
PC

2-blue (short), 1-red (long) Unable to obtain DHCP 
address

Check router, If using a static IP 
address, reconfigure the HO 
Media Vault, for more 
information see You prefer to 
set static IP Addresses on 
page 12-168
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can typically turn off the wireless network radio on laptops to disable that 
adapter.

You Receive Microsoft Vista Permission Messages
As part of its enhanced security, the Microsoft Vista operating system may 
display User Account Control dialog boxes. These dialog boxes help stop 
unauthorized changes to your computer and require permission to continue 
with the action.
Note: Always check that the action needing your permission is one that you 
intended. The source of the action is displayed in the middle band of the 
dialog box.

A list of the HP Media Vault's applications that may require permission is 
located below the following User Account Control dialog boxes:

User Account Control - Administrator Password
The following HP Media Vault applications may require permission to 
continue:
• HPMVTray.exe - HP Media Vault System Tray utility
• Cddib32.exe - NTI DriveBackup!
• Shadow.exe - NTI Shadow
• NASSelector.exe - Media Vault Selection Application
• NASDriveMapper.exe - NASDriveMapper Application

Restoring a Mirrored Volume
A mirrored volume is a volume that protects sensitive data by keeping two 
copies of your data on separated physical hard disks. This insures that if a 
hard disk failure occurs, all the data on the volume is still intact and the 
volume is still available for reading and writing. But your data is no longer 
protected by a redundant copy.

When one half of a mirrored volume is missing from the device, or has failed, 
you should restore the missing or failed disk as soon as possible.

Removing a Mirror
Removing a mirror does not destroy the entire volume, but only one of the 
redundant copies.
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To remove a mirrored volume that you no longer want or need, see Remove a 
Mirror.

Mirror rebuilding when one of the disks has been removed, 
then reconnected
If one disk containing a volume mirror is disconnected, mirroring is 
interrupted. Reconnecting the same disk does not cause the mirror to 
completely rebuild. Once that same disk is reconnected to the HP Media 
Vault, Click the FIX button to begin the rebuild. Please be aware that while 
this rebuilding operation is taking place, your data is not protected with a 
redundant copy. Also be aware that the mirror rebuild may take many hours.

Mirror restoration when a disk (other than the SYSTEM disk) 
has failed
When a disk (other than the SYSTEM disk) for a mirrored volume fails, the HP 
Media Vault raises a system tray alert that warns you of the loss of data 
redundancy. To restore the device to the same level of protection, you must 
remove the failed hard disk and replace it with a new, working disk. 
However, the device does not presume that the new disk was attached to 
recreate the missing half. 

Power-on Indicator is Off
The HP Media Vault is not powered on.

To power on the HP Media Vault

1 Make sure the power cord is fully plugged into the HP Media Vault and a 
powered electrical outlet.

2 If plugged into a surge protector or power strip, make sure the device is 
switched on.

What to do if the HP Media Vault is Unresponsive
If the HP Media Vault appears to be unresponsive, do either of the following:
• Restarting the HP Media Vault Using the Control Center
• Shutdown and restart the HP Media Vault manually

Restarting the HP Media Vault Using the Control Center
How to reset the HP Media Vault from the HP Media Vault Control Center.
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To reset the HP Media Vault

1 Double-click the HP Media Vault Monitor icon  in the task tray.
2 On the HP Media Vault Control Center, click Tools, then click 

Customize HP Media Vault.
3 Click the System tab, then click either the Shutdown or the Restart 

icons in the upper right corner of the console.

Shutdown and restart the HP Media Vault manually
How to force the HP Media Vault to turn off and restart.

To perform a soft shut down and restart

1 On the back of the HP Media Vault, press the Power button.
2 The health light should begin blinking.

The shutdown process may take up to two minutes to complete.
3 After the HP Media Vault is completely off, press the Power button to 

restart.

To force a shutdown and restart

If the HP Media Vault can not be restarted using any of the above methods, 
then try disconnecting the power cord and reconnecting it.

Why is the Hard Drive Light-bar Purple?
A purple light bar  indicates that a hard drive has been installed, but 
has not been initialized. It occurs in the following conditions:
• User has clicked “Remove” on the discs tab.
• When adding a new drive, before is has been added to HP Media Vault 

storage.

Why is the Hard Drive Light-bar Red?
A red light-bar  indicates that a hard drive has failed and must be 
replaced.
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Why does my HP Media Vault Shut Down by Itself?
The HP Media Vault has a temperature sensor and if the sensor records a 
temperature of 57o C, the unit will shut down. 

Check that the unit has unobstructed airflow, and that the unit is not in an 
small enclosed.

Turn the unit on and listen for a fan, if you do not hear a fan or the unit 
continues to shut down, contact HP support.

Computer Recovery (this option is only available on the 
HP Media Vault Pro)
To help you recover your computer and data in the event of a hard drive 
failure, the HP Media Vault includes a Drive Backup application. A drive 
backup must be accomplished prior to a hard drive failure for a Computer 
Recovery to be successful. Use this disc to restore your computer from the HP 
Media Vault in the event of the following:
• To restore the system drive.
• When the operating system will not start (boot).
• If you cannot use System Restore to restore the system files.

Important: To ensure that you have the latest version of the PC Restore Disc, 
contact HP support at http://www.hp.com/support.

To recover your computer

1 Insert the PC Restore Disc into a CD/DVD drive in the computer you want 
to restore.

2 Restart the computer, and boot from the CD.
3 Follow the instructions in the Restore application.

Router
You must configure your router to access your Photo Webshare from outside 
the home network and to use remote access. After clicking Setup, the HP 
Media Vault will automatically try to configure your broadband router.
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My HP Media Vault Loses its Router Settings
During the configuration of the HP Media Vault’s Remote Access, if you chose 
Automatically Setup Router, and the Router has experienced a restart 
or anything that would cause the router to lose power and/or restart, the 
settings have been lost. The reason is that the settings are kept in volatile 
memory, and are erased whenever the router loses power. You can avoid this 
in the future by manually setting the router.

The steps below will assist in reconfiguring of the router. 

1 At the computer, click Start, All Programs, HP Media Vault, and 
then Control Center.

2 On the Tools tab, click Customize HP Media Vault.
You are prompted for an administrator name and password if you set one 
up. For additional information, see Editing System Settings on page 2-26.

3 Click the Remote Access tab.

Figure 51: The Remote Access Setup page after a personal web address is 
created.

4 Click Set up Router.
The Remote Access Setup|Router Configuration page displays.
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Figure 52: The Remote Access Setup|Router Configuration page.

5 Click Manually Set up Router.
The Manual Router Setup page displays with information that will be 
required to manually set up your router.
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Figure 53: The Manual Router Setup page.

6 Click Access your router.
The HP Media Vault attempts to open your router configuration page. The 
page that displays is unique to your router. If you have questions about 
configuring your router for port forwarding, see the documentation that 
came with the router.

7 Click Done on the HP Media Vault Remote Access Setup|Router 
Confirmation page when you are finished setting up your router.

What are the Minimum Browser Requirements Needed by 
the Online User's Guide?
For best results, use the latest version of browser with JavaScript enabled. See 
instructions below:

The navigation menu does not appear in the browser window
JavaScript is not enabled in your web browser.

To enable JavaScript in Internet Explorer 6.0 or 7.0:

Internet Explorer 6.0 or later is required for this product.
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1 Go to Tools, Internet Options.
2 Click the Security tab.
3 Click Default Level. This sets the level to Medium and enables 

javascript.
4 To enable only javascript:

a Click Custom Level.
b In the Security Settings window scroll down until you get to the section 

called Scripting (near the bottom).
c In the category Active scripting, select Enable.
d In the Security Settings window, click OK.

5 In the Internet Options window, click OK.

To enable JavaScript in Firefox:

These instructions apply to Firefox 1.5 and above.

Go to Tools, Options, and then select Enable JavaScript.

To enable JavaScript in Netscape:

These instructions apply to Netscape 8.1.

1 Go to Tools, Options.
2 In the Options window, click Site Controls.
3 In the Master Settings pane, click I trust this Site.
4 Click OK.

To enable JavaScript in Safari:

These instructions apply to Safari 1.2.

1 Go to Safari, Preferences.
2 Click the Security icon.
3 In the Web Content pane, click the Enable JavaScript check box.
4 Close the window.

The menu appears garbled after resizing the text
Refresh the screen.
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Network Connection Troubleshooting Tips
In this section we will cover:

Network connection issues on page 12-163

No available port on network router on page 12-167

Why did URL not work? on page 12-167

You receive firewall blocking messages on page 12-167

You prefer to set static IP Addresses on page 12-168

Network Connection Issues
For issues connecting the server to the network, check the following:
• Why is the Network Connection Light Off on page 163
• The firewall is blocking the connection on page 12-163
• Check that the router is correctly configured for DHCP on page 12-164
• Check the network is set up properly for TCP/IP on page 12-164
• Check the network NetBIOS properties on page 12-166

Why is the Network Connection Light Off

To Determine why the Network Connection Light is Off

1 Make sure that all the cable connections are correctly plugged in. 
2 Make sure the router or switch has power.
3 Restart the router or switch (or unplug and plug it back in).
4 If you are using your own Ethernet cable, try using the Ethernet cable that 

came with the HP Media Vault.

The Network Connection Light Alternates Between Blue and Off

The server is intermittently connected to the network. 

Check the cable connection between the server and the router (or switch).

The Firewall is Blocking the Connection
If using a firewall program, configure it to allow any HP MediaSmart 
applications:
• HPMVTray.exe - HP Media Vault System Tray utility
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• Cddib32.exe - NTI DriveBackup!
• Shadow.exe - NTI Shadow
• NASSelector.exe - Media Vault Selection Application
• NASDriveMapper.exe - NASDriveMapper Application

For instructions to unblock, see the software vendor's documentation. 

For information about firewall blocking alerts, see You receive firewall 
blocking messages on page 12-167.

Check that the Router is Correctly Configured for DHCP 
The HP Media Vault comes automatically set to use a Dynamic Host 
Configuration Protocol (DHCP) server to dynamically assign IP addresses. 
Most router come with a built-in DHCP server.

Check that the router has the DHCP server correctly enabled. Refer to the 
documentation that came with the router for instructions on proper DHCP 
server configuration. 

For information about configuring a router for remote access, see the 
following sections.

Windows Vista: Check that Network Discovery is Turned On

To ensure that Network Discovery is turned on

1 Click the Start menu, and then select Control Panel.
2 In the Control Panel, click View network status and tasks.
3 In the Network and Sharing Center, make sure that Network discovery is 

on. 

4 If Network discovery is off, click , then select Turn on network 
discovery and Apply.

Check the Network is Set Up Properly for TCP/IP
Check that each computer on the network has TCP/IP listed and selected for 
the network properties with these options selected: 
• Obtain IP address automatically
• Obtain Domain Name System (DNS) server address automatically
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Windows XP: To Ensure Your Network is Set Up Properly for 
TCP/IP

1 Click Start, and then select Control Panel. 
2 Double-click Network and Internet Connections.
3 Double-click Network Connections.
4 If the computer is connected via Ethernet cable to the network, right-click 

Local Area Connection. 
5 If the computer is using a wireless connection, right-click Wireless 

Network Connection.
6 Click Properties. In the dialog box that opens, check to ensure that 

TCP/IP (Transmission Control Protocol/Internet Protocol) is listed and 
selected. 

If TCP/IP is not listed, click Install, Protocol, and then Add. In the 
dialog box that appears, select Internet Protocol (TCP/IP). 
If TCP/IP is listed and checked, highlight it and click Properties, then 
select Obtain IP address automatically and Obtain DNS 
server address automatically. 

7 All computers should be set identically.

Windows Vista: To Ensure Your Network is Set Up Properly for 
TCP/IP

1 Click Start, and then select Control Panel. 
2 Click View network status and tasks under Network and 

Internet.
3 In the left pane, click Manage Network Connections.
4 If the computer is connected via Ethernet cable to the network, right-click 

Local Area Connection. 
5 If the computer is using a wireless connection, right-click Wireless 

Network Connection.
6 Click Properties. In the dialog box that opens, check to ensure that 

Internet Protocol Version 4 TCP/IPv4 is listed and selected. 
If TCP/IP is not listed, click Install, Protocol, and then Add. In the 
dialog box that appears, select Internet Protocol (TCP/IPv4). 



Version 12-
166

If TCP/IP is listed and checked, highlight it and click Properties, then 
select Obtain IP address automatically and Obtain DNS 
server address automatically. 

7 All computers should be set identically.

Check the Network NetBIOS Properties
Check that each computer on the network has TCP/IP advanced network 
properties set to Enable NetBIOS over TCP/IP. All computers should be set 
identically. 

Windows XP: To Ensure your Network has the Correct NetBIOS 
Set Up 

1 Click Start, and then select Control Panel.
2 Double-click Network and Internet connections. 
3 Double-click Network Connections.
4 Double-click your default network connection.

Local Area Connection for wired networks.
Wireless for wireless connections.

5 Click Properties. 
6 Highlight Internet Protocol (TCP/IP). 
7 Click Properties. 
8 Click Advanced. 
9 Click the WINS tab.

WINS refers to Windows Internet Naming Service, which converts 
NetBIOS network names to IP addresses.

10 NetBIOS settings are found at the bottom of the dialog box. Make sure 
that the NetBIOS setting is not set to Disable NetBIOS over TCP/IP. 

Windows Vista: To Ensure your Network has the Correct 
NetBIOS Set Up

1 Click Start, and then select Control Panel. 
2 Click View network status and tasks under Network and 

Internet.
3 In the left pane, click Manage Network Connections.
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4 Right-click your default network connection:
Local Area Connection for wired networks.
Wireless Network Connection for wireless connections.

5 Highlight Internet Protocol Version 4 (TCP/IP). 
6 Click Properties. 
7 Click Advanced. 
8 Click the WINS tab. 

WINS refers to Windows Internet Naming Service, which converts 
NetBIOS network names to IP addresses.

9 NetBIOS settings are found at the bottom of the dialog box. Make sure 
that the NetBIOS setting is not set to Disable NetBIOS over TCP/IP. 

No Available Port on Network Router
Take the following steps:

1 To add more Ethernet ports, connect an Ethernet switch to the router. Refer 
to the switch documentation for instructions on how it connects to the 
router.

2 Connect one end of the Ethernet cable that came with the server to the 
switch and the other end to the HP Media Vault.

Why Did URL Not Work? 
DNS has not updated, wait about 10 minutes for DNS to update.

You Receive Firewall Blocking Messages
If you update Windows XP to the most recent software and service packs, it is 
likely that you've installed the Windows Firewall. You might also have another 
firewall program installed on your computer. Firewalls block certain types of 
communications between various network devices. This helps protect your 
data from hackers, viruses, spyware, and Trojan-horse software.

The HP Media Vault comes with software applications that must communicate 
over the network, but sometimes these programs are blocked, by default, by a 
firewall. When this happens, security alerts pop up on your screen. Security 
alert dialog boxes usually have a list of possible options. For example, the 
dialog box might ask you the following three questions:
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1 Click Keep Blocking.
2 Click Unblock.
3 Defer the choice and be reminded later.

If you see a security alert dialog for an HP Media Vault application or an NTI 
backup application, you should unblock the communication to permit the 
application to run. You are safe to unblock the communications because you 
are not enabling any connection or communication with the Internet, only 
between the HP Media Vault and its software applications.

The following list comprises the software applications that need to 
communicate with the HP Media Vault:
• HPMVTray.exe - HP Media Vault System Tray utility
• NASSelector.exe - HP Media Vault Browse utility

• NASDriveMapper.exe - HP Media Vault Drive Mapping utility
• Cddib32.exe - NTI DriveBackup!
• Shadow.exe - NTI Shadow

If any software is reinstalled, moved to a new disk location, or if the 
application is deleted from the exception list using the Security Center control 
panel, communications between that software and the HP Media Vault may 
once again be blocked by the firewall.

You Prefer to Set Static IP Addresses
If you have a router with a DHCP server properly configured, the DHCP server 
automatically (dynamically) assigns an IP address to the HP Media Vault. 
When you install the HP Media Vault, it waits for your router to automatically 
assign it an IP address. If the router fails to assign an IP address, the HP 
Media Vault automatically uses the following IP address and subnet mask:
• Auto IP address: 169.254.100.100
• Subnet mask: 255.255.0.0

You may prefer to assign static IP addresses. To assign the HP Media Vault a 
static IP address:
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1 Turn on the DHCP server in your router. Consult your router 
documentation for more information.

2 Ensure that the IP addresses assigned by your router are within the same 
subnet as your other network devices.

3 Restart your router and the HP Media Vault.
4 At the computer, click Start, All Programs, HP Media Vault, and 

then Control Center.
5 Click Customize your HP Media Vault’s settings.
6 If the Welcome screen appears, click Configure Device.
7 Click the Network Settings tab.
8 Click the Manually Configure IP Settings option.
9 In the IP Address box, enter a unique IP address.
10 Click Accept.
11 In the Subnet Mask box, enter the subnet.
12 Reconfigure your router back to its original settings.

13 Restart your HP Media Vault.

Webshare Troubleshooting Tips
In this section we will cover:

Why can’t I share my album? on page 12-170

How to add photos from your photos shared folder to your Webshare. on 
page 12-170

Unable to upload images. on page 12-171

How do you make Webshare work in the home? on page 12-171

Why am I getting a certificate error? on page 12-171

Upload Photos requires ActiveX control to be loaded? on page 12-172

Clicking on photo Webshare on Control Center Does Not Open. on page 12-
172

Webshare administrator cannot delete Visitor account. on page 12-172
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Visitor can create a photo album and add pictures but the album doesn't 
display. on page 12-172

Visitor cannot download pictures and sees a message telling them that they 
cannot download pictures. on page 12-172

Visitor cannot add pictures and sees a message telling them that they can't 
add pictures. on page 12-172

Visitor has created an album (or albums) and wants to delete the album but 
cannot. on page 12-172

Visitor has changed their password, now they can't log into Webshare. on 
page 12-173

Selecting URL from address field in web browser loads “page that opens 
cannot be closed without closing the entire application”. on page 12-173

Webshare user is unable to log out of Webshare. on page 12-173

Trouble uploading large files to Webshare. on page 12-173

Clicking on Photo Webshare on Control Center causes command error. on 
page 12-173

Browser cannot display the page when accessing through URL. on page 12-
173

Why can’t I Share My Album?
Server users can create albums, but not share them.

How to Add Photos from Your Photos Shared Folder to 
Your Webshare
Cannot access/browse server shares from the photo selector.

1 Use the photo loader, on the left hand side to browse Network 
Neighborhood (XP PCs) or Network (Vista PCs). 

2 If your server shared folder does not show up in this list, then use the 
desktop shortcut to access shared folders on the server, right click on the 
shared folder you wish to use, and click on "map network drive". 

3 The next time you use the photo loader, browser to my computer and 
select the drive previously mapped.
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Unable to Upload Images

• Installs may be blocked by browser security.
Click to enable download/install at top of browser.

• Just inserted the drive while Upload photo was loading.
Reinsert the thumb drive.

• Pop up blocker blocked install.
Disable pop up blocker, or enable pop ups for the URL.

• ActiveX is disabled.
Enable ActiveX.

• Not using Internet Explorer.

Use Internet Explorer.

How do you Make Webshare Work in the Home?
Once remote access is setup and you have a custom domain name, 
frequently urls that look something like https://{your domain name}/
Webshare/ will be used. For many internet service providers, this can cause 
problems and occasionally even redirect you to your home network router or 
modem.

To work around this:

1 Replace the {your domain name} section of the URL address with the local 
name of your server (the default is “HPMediaVault”).

2 In addition to removing common network issues, this will also perform 
faster.

Why am I Getting a Certificate Error? 
If you access your HP Media Vault you will get a warning about the server's 
security certificate whenever you access any of its https:// URLs. The reason 
is that the server issues its own security certificate, and since it is not an 
official Certificate Authority, your web browser issues the warning or error 
message.

You may ignore the warning or error message and continue to the HP Media 
Vault's web pages.
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Upload Photos Requires ActiveX Control to be Loaded? 
Alternately, you can use non-ActiveX. Add photos to add photos to your 
album.

Clicking on Photo Webshare on Control Center Does Not 
Open 
No Default Browser. Select a default browser or reboot PC.

Webshare Administrator Cannot Delete Visitor Account 
Added visitor as User in Media Vault Console. Add the visitor in Webshare 
instead on in the Admin Console.

Visitor Can Create a Photo Album and Add Pictures but 
the Album Doesn't Display
Visitor does not have auto-approve rights.

This is expected behavior for a Webshare Visitor who has permission to add 
photos. The photos must be approved by a Webshare administrator before 
they will display in the photo album.

Visitor Cannot Download Pictures and sees a Message 
Telling them that they Cannot Download Pictures
Visitor does not have download rights.

Downloading permissions are set by the Webshare administrator.

Visitor Cannot Add Pictures and sees a Message Telling 
them that they Cannot Add Pictures 
Visitor does not have add rights.

Permission to add pictures to photo albums are set by the Webshare 
administrator.

Visitor has Created an Album (or Albums) and Wants to 
Delete the Album but Cannot 
Visitors do not have delete album rights. 
Visitor should delete the photos from the file. The Webshare administrator has 
permissions to delete photo albums.
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Visitor has changed their password, now they can't log 
into Webshare 
Visitor has changed their password in Webshare to nothing (using "Change 
Password" link). Now they can't log into Webshare. They are getting a 
message about their password being incorrect users can create albums, but 
not share them.

The Webshare admin has edited the Visitor's password. 

There is an option on the Webshare login page to obtain a new password.

Selecting URL From Address Field in Web Browser Loads 
“Page that Opens Cannot be Closed Without Closing the 
Entire Application”
Webshare Visitor or Administrator is selecting URL from address field in web 
browser and after login the page that opens cannot be closed without closing 
the entire application. 

Browser remembers previous credentials.

Type IP into browser address field, (e.g. 192.168.1.103) and save the login 
page as a Favorite.

Webshare User is Unable to log out of Webshare 
Browser remembers previous credentials.

There is no logout screen for Webshare. Closing the browser will log out the 
user if credentials not saved.

Trouble Uploading Large Files to Webshare
The download may time out.

Clicking on Photo Webshare on Control Center Causes 
Command Error 
Click OK on error and attempt to open Photo Webshare again.

Browser Cannot Display the Page When Accessing 
Through URL 
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• Multiple DHCP devices are on the network.
Verify that there is only one DHCP server on the network - VOIP devices 
often are DHCP servers.

• Accessing the server through the URL while behind the same router has 
known issues.
Access the server through the local name (Photo Webshare in Control 
Center) and use the URL when outside the network.

• Upnp not supported by router.
Enable port forwarding for ports 80 and 443 to the server's IP address.

iTunes Troubleshooting Tips
In this section we will cover:

iTunes aggregator does not appear to be working. on page 12-174

Song selection from the server is not updating with new additions. on 
page 12-174

Podcasts not showing in playlist. on page 12-175

iTunes Aggregator does not Appear to be Working

• No music in iTunes library.
Add music to library.
Check C:\Program Files\Hewlett-Packard\Media Aggregator.txt.

• Accounts may not match or guest account disabled.
Fix account synchronization.

Song Selection from the Server is not Updating with new 
Additions
Server has not refreshed yet.
• Wait for the Server to synchronize.
• Click on eject button on the Server bar.
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Podcasts not Showing in Playlist.
Podcasts copied over will not show in playlist for server.

Email Troubleshooting Tips
In this section we will cover:

Why do I need email address for visitors and Home Server users? on 
page 12-175

Why do I need to set-up Webshare notifications? on page 12-175

File doesn't appear. on page 12-175

Emailed link not opening. on page 12-175

Email is not received. on page 12-176

Why do I Need eMail Address for Visitors and Home 
Server users?
Webshare has a notification mechanism that uses email to share photos with 
others. In order for Webshare to send email and notify other users or visitors, 
you must configure and enable Webshare email notification in the remote 
access configuration. 

Why do I Need to Set-up Webshare Notifications?
Webshare has a feature to send email notifications whenever items are 
shared with others, and the email addresses of these users is required. It is 
recommended that visitor accounts always use the same email as the user 
name, as opposed to having a different user name than the email address of 
a visitor (which can add confusion for visitors). Email for Home Server users 
must be set up separately within Webshare, as there is no other location that 
uses the email address of Home Server users.

File Does not Appear
File type may not be supported, may need to convert file to supported type.

Emailed Link not Opening
Web site connectivity not on, turn web site connectivity on
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Email is not Received
Verify that the correct email address was entered.

Media Streaming Troubleshooting tips
In this section we will cover:

You’re unable to stream media to your entertainment center on page 12-176

Why can I play and stream DRM content on my home computer but I can not 
stream it from my HP Media Vault? on page 12-177

If your DMA does not display your files are found by the DMA. on page 12-
178

If some of your files (e.g., files newly copied to the server) are not found by 
the DMA. on page 12-178

You’re Unable to Stream Media to your Entertainment 
Center

1 Make sure that your HP Media Vault is powered up and working before 
you power up your Digital Media Adapter (DMA).

2 Check to make sure that your DMA supports the DLNA/UPnP protocols, 
which are the protocols supported by the HP Media Vault. Some DMAs 
use proprietary protocols that do not operate with the HP Media Vault’s 
media server. For a list of compatible DMAs, consult the HP support web 
site at www.hp.com/support.

3 Ensure that your DMA is using the latest firmware revision. Consult your 
DMA documentation for more information on updating its firmware.

4 The HP Media Vault’s media server supports the playback of the following 
file types:
Video: .mpg, .wmv, .mp4, .avi, .asf, .mov, .vob, .mpe, .ts, .dvr-ms, 
.m2v, .mpeg, .m2p, .divx, xvid, .dat, .m1v, .m4v
Music: .mp3, .ogg, .wav, .lpcm, .pcm, .wma, .mp2, .ac3, .m4a, .aac, 
.mpa, .mp1, .aif
Photo: .jpg, .jpeg, .png, .tif, .tiff, .bmp, .gif
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Note: Some DMAs have playback restrictions for certain types of 
multimedia files. Check your DMA documentation for supported and 
unsupported file types.

5 New multimedia files can take a considerable amount of time to show up 
on your DMA. The streaming process requires the HP Media Vault’s 
media server to scan through new multimedia files to gather information, 
such as artist names, song titles, video names, and so on. This process 
often takes a long time especially if there are a large number of files. 
Once the scanning process completes, you can see the files on your 
DMA.

6 Reset the media streaming database. For more information, see Reset 
media streaming.

Why can I Play and Stream DRM Content on my Home 
Computer but I Can Not Stream it From my HP Media 
Vault?
The HP Media Vault includes a media server for streaming iTunes music to 
PCs running iTunes through the house. See the section in the User's Guide on 
iTunes.

For Windows Media DRM (WMDRM) content (protected .wma music and 
.wmv videos), the HP Media Vault does not support streaming of this content 
to DMAs. Playing (and streaming) of WMDRM protected content requires that 
the device that is playing the content have a license for the content. When 
you downloaded the content to your PC, you also received a license to play 
the content on that PC. If you copy the files to the HP Media Vault, you cannot 
copy or transfer the license to the server. The server must obtain its own 
license, and we do not provide for this feature in the current product.

What you can do however, is store your protected content on the HP Media 
Vault. This allows all of the PCs in the home that have a license for the content 
to play it from the HP Media Vault by accessing it through the network. For 
example, to add all of the music on your HP Media Vault to the Windows 
Media Player library on your PC:

Open Windows Media Player on your PC.

Select File -> Add to Media Library -> Add Folder ….

In the Add Folder dialog, type \\HPMediaVault\Music and click OK.
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This will add all of the music files in your Music shared folder on the HP 
Media Vault to your Windows Media Player library. You will then be able to 
play all of the protected content for which this PC has a license.

If your DMA Does not Display your Files are Found by the 
DMA

1 Check that the HP Media Vault and DMA are both connected to the same 
home network (a router or firewall between them could interfere with the 
discovery and content sharing protocols).

2 Restart the DMA.

3 Restart the HP Media Vault server.

If Some of Your Files (e.g., Files Newly Copied to the 
Server) are not Found by the DMA 

1 Check that the files were copied to the correct location. Only the Music, 
Photos and Videos shared folders may be enabled for media sharing by 
default. Note that all folders below that are also enabled for media 
sharing.

2 Re-enable the shared folder for media sharing.
Turn sharing Off for the shared folder with the missing files and select 
Apply.
Turn sharing back On for the shared folder and select Apply.

3 Restart the DMA.
4 Restart the HP Media Vault.
5 On the Server tab click Reset the Media Server.
6 Only music files are served from the music share, video files are served 

from the video share, and photo files are served from the photo share,
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13 Product Information
What’s in this chapter
» Product Specifications
» Regulatory Statements
» Limited Warranty and Technical Support Statement

Product Specifications
The product specifications contain the following information about the HP 
Media Vault, its requirements, and standards.

• HP Media Vault Specifications
• Minimum Client-computer Requirements
• Network
• Environmental

HP Media Vault Specifications
• Package Contents

HP Media Vault mv2120 includes:
HP Media Vault, power adapter, power cable, ethernet cable, printed 
Setup Poster, printed Warranty & Support Guide, HP Media Vault 
software and manual on CD. 
The HP Media Vault Pro mv5000 series includes the above contents plus 
a PC Restore Disc.

• Dimensions
Height: 137mm (5.4")
Width: 139mm (5.5")
Depth: 244mm (9.6")

• Weight
HP Media Vault mv2120: 3.2 kg (7.05 lb.) (2.81 kg (6.2 lb.) without 
power supply)
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HP Media Vault Pro mv5140: 3.74 kg (8.25 lb.) (3.36 kg (7.4 lb.) without 
power supply)

• Internal Hard Drive
SATA 7200 RPM 

• Storage Capacity
HP Media Vault mv2120: 500 GB with 1 SATA expansion bay
HP Media Vault mv5020: 500 GB with 1 SATA expansion bay
HP Media Vault Pro mv5140: 1 TB
HP Media Vault Pro mv5150: 1.5 TB
2 USB 2.0 ports: 1 on front, 1 on back
Maximum storage space: 4 terabytes with a maximum of 1 terabyte per 
drive. The configuration for maximum storage is 2 internal and 2 external 
drives.

• Mirroring
Can be configured as RAID 1 (a redundant copy of your files) with 
second hard drive in expansion bay.

• Remote Access
Remote access requires setting up a free or charge-based account with 
TZO dynamic DNS service. 
Broadband Internet connection required for remote access.

• File Sharing
Supports file sharing from Windows, Mac, and Linux-based computers 
over a home network.

Minimum Client-computer Requirements
Your computer should meet or exceed these requirements:
• Computer Requirements

1 GHz Intel Pentium III processor or equivalent with 256MB RAM.
• Operating Systems

File and Drive backup: Microsoft Windows XP Home, XP Professional, 
Microsoft Windows Vista - Home Basic, Home Premium, Business, and 
Ultimate editions.
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File sharing: Microsoft Windows XP Home, XP Professional, Microsoft 
Windows Vista - Home Basic, Home Premium, Business, and Ultimate 
editions, MAC OSX, Linux.

• Available Hard Drive Space
150 MB free for included software installation

• Browser
Internet Explorer 6.0 or greater, Netscape 7.0 or greater, or Firefox 1.0 or 
greater

• Other Client-computer Requirements
CD-ROM drive for client-computer installation
Home Network

Internet connectivity recommended for software updates

Network
• Default Network ID

HPMediaVault
• Supported Network Protocols

IEEE 802.3
IEEE 802.3u
UPnP™ AV 1.0
HTTP/HTTPS

• Network Speed
10/100/1000 (Gigabit) RJ45 Ethernet

• Access Method (methods used to record data)
CSMA/CD

• Connector Type
1x RJ45

• Encoding Method
100BASE-TX: 4B5B,
MLT-3 10BASE-T: Manchester coding

• Maximum Transmission Distance
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100 meters

Environmental
• Temperature

Operating: 5° to 40° C (41° to 104° F)
Nonoperating: -40° to 70° C (-40° to 158° F)

• Humidity (no condensation allowed)
Operating: 15% to 90% RH
Nonoperating: 5% to 95% RH

• Shock
Nonoperating: 85 G

• Vibration
Operating: 0.2 Grms
Nonoperating: 2.0 Grms

• Electrical Ratings
18.5Vdc, 3.5A

• Power Consumption
Power Consumption: 18W single drive, 31W dual drive

• Safety
IEC 950-compliant
USA – UL, CDRH Radiation Control Standards 21
CFR 1010 and 1020-1 0.50
Canada – CSA or CUL
Europe – LVD 73/23/EEC 93/68/EC
IEC 60950 plus amendments,
EN60825 plus amendments,
EMCD 89/336/EEC plus amendments

• Battery Disposal Warning
Perchlorate material – special handling may apply. See http://
www.dtsc.ca.gov/hazardouswaste/perchlorate/
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This product’s real-time clock battery or coin cell battery may contain 
perchlorate and may require special handling when recycled or disposed 
of in California.

Regulatory Statements
The HP Media Vault complies to the following:
• Federal Communications Commission Notice
• Modifications
• Cables
• Declaration of Conformity for Products Marked with the FCC Logo (United 

States only)
• Canadian Notice

• Avis Canadien
• European Union Regulatory Notice
• Japanese Notice

Federal Communications Commission Notice
This equipment has been tested and found to comply with the limits for a 
Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. 
However, there is no guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off 
and on, the user is encouraged to try to correct the interference by one or 
more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and the receiver.
• Connect the equipment into an outlet on a circuit different from that to 

which the receiver is connected.
• Consult the dealer or an experienced radio or television technician for 

help.
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Modifications
The FCC requires the user to be notified that any changes or modifications 
made to this device that are not expressly approved by Hewlett-Packard 
Company may void the user's authority to operate the equipment.

Cables
Connections to this device must be made with shielded cables with metallic 
RFI/EMI connector hoods in order to maintain compliance with FCC Rules 
and Regulations.

Declaration of Conformity for Products Marked with the 
FCC Logo (United States only)
This device complies with Part 15 of the FCC Rules. Operation is subject to the 
following two conditions:

1 This device may not cause harmful interference, and
2 This device must accept any interference received, including interference 

that may cause undesired operation.

For questions regarding the product, contact:
Hewlett-Packard Company
P. O. Box 692000, Mail Stop 530113
Houston, Texas 77269-2000

Or, call 1-800-HP-INVENT (1-800-474-6836).

For questions regarding this FCC declaration, contact:
Hewlett-Packard Company
P. O. Box 692000, Mail Stop 510101
Houston, Texas 77269-2000

Or, call (281) 514-3333.

To identify this product, refer to the part, series, or model number found on 
the product.

Canadian Notice
This Class B digital apparatus meets all requirements of the Canadian 
Interference-Causing Equipment Regulations.
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Avis Canadien 
Cet appareil numérique de la classe B respecte toutes les exigences du 
Règlement sur le matériel brouilleur du Canada.

European Union Regulatory Notice
This product complies with the following EU Directives:
• Low Voltage Directive 2006/95/EC
• EMC Directive 2004/108/EC

Compliance with these directives implies conformity to applicable 
harmonized European standards (European Norms) which are listed on the 
EU Declaration of Conformity issued by Hewlett-Packard for this product or 
product family.

This compliance is indicated by the following conformity marking placed on 
the product:

Hewlett-Packard GmbH, HQ-TRE, Herrenberger Strasse 140, 71034 
Boeblingen, Germany

Japanese Notice

Limited Warranty and Technical Support Statement
HP Media Vault Limited Warranty
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Duration

Hardware: 1 year Limited Warranty

Software: 1 year Technical Support

General Terms

This HP Hardware Limited Warranty gives you, the customer, express limited 
warranty rights from HP, the manufacturer. Please refer to HP’s Web site for 
an extensive description of your limited warranty entitlements. In addition, 
you may also have other legal rights under applicable local law or special 
written agreement with HP.

HP MAKES NO OTHER EXPRESS WARRANTY OR CONDITION, WHETHER 
WRITTEN OR ORAL, AND HP EXPRESSLY DISCLAIMS ALL WARRANTIES 
AND CONDITIONS NOT STATED IN THIS LIMITED WARRANTY. TO THE 
EXTENT ALLOWED BY THE LOCAL LAW OF JURISDICTIONS OUTSIDE THE 
UNITED STATES, HP DISCLAIMS ALL IMPLIED WARRANTIES OR 
CONDITIONS, INCLUDING ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FOR ALL 
TRANSACTIONS OCCURRING IN THE UNITED STATES, ANY IMPLIED 
WARRANTY OR CONDITION OF MERCHANTABILITY, SATISFACTORY 
QUALITY, OR FITNESS FOR A PARTICULAR PURPOSE IS LIMITED TO THE 
DURATION OF THE EXPRESS WARRANTY SET FORTH ABOVE. SOME 
STATES OR COUNTRIES/REGIONS DO NOT ALLOW A LIMITATION ON 
HOW LONG AN IMPLIED WARRANTY LASTS OR THE EXCLUSION OR 
LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES FOR 
CONSUMER PRODUCTS. IN SUCH STATES OR COUNTRIES/REGIONS, 
SOME EXCLUSIONS OR LIMITATIONS OF THIS LIMITED WARRANTY MAY 
NOT APPLY TO YOU.

THE LIMITED WARRANTY TERMS CONTAINED IN THIS STATEMENT, 
EXCEPT TO THE EXTENT LAWFULLY PERMITTED, DO NOT EXCLUDE, 
RESTRICT, OR MODIFY BUT ARE IN ADDITION TO THE MANDATORY 
STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.

This Limited Warranty is applicable in all countries/regions and may be 
enforced in any country/region where HP or its authorized service providers 
offer warranty service for the same product model number subject to the terms 
and conditions set forth in this Limited Warranty.
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Under the HP Global Limited Warranty program, products purchased in one 
country/region may be transferred to another country/region, where HP or 
its authorized service providers offer warranty service for the same product 
model number, without voiding the warranty. Warranty terms, service 
availability, and service response times may vary from country/region to 
country/region. Standard warranty service response time is subject to change 
due to local parts availability. If so, your HP authorized service provider can 
provide you with details.

HP is not responsible for any tariffs or duties that may be incurred in 
transferring the products. Transfer of the products may be covered by export 
controls issued by the United States or other governments.

This Limited Warranty applies only to HP-branded and Compaq-branded 
hardware products (collectively referred to in this Limited Warranty as “HP 
Hardware Products”) sold by or leased from Hewlett-Packard Company, its 
worldwide subsidiaries, affiliates, authorized resellers, or country/region 
distributors (collectively referred to in this Limited Warranty as “HP”) with this 
Limited Warranty. The term “HP Hardware Product” is limited to the hardware 
components and required firmware. The term “HP Hardware Product” DOES 
NOT include any software applications or programs; non-HP products or non-
HP branded peripherals. All non-HP products or non-HP branded peripherals 
external to the HP Hardware Product — such as external storage subsystems, 
displays, printers, and other peripherals — are provided “AS IS” without HP 
warranty. However, non-HP manufacturers and suppliers, or publishers may 
provide their own warranties directly to you.

HP warrants that the HP Hardware Products that you have purchased or 
leased from HP are free from defects in materials or workmanship under 
normal use during the Limited Warranty Period. The Limited Warranty Period 
starts on the date of purchase or lease from HP or from the date HP completes 
installation. Your dated sales or delivery receipt, showing the date of 
purchase or lease of the product, is your proof of the purchase or lease date. 
You may be required to provide proof of purchase or lease as a condition of 
receiving warranty service. You are entitled to hardware warranty service 
according to the terms and conditions of this document if a repair to your HP 
Hardware Product is required within the Limited Warranty Period.

Unless otherwise stated, and to the extent permitted by local law, new HP 
Hardware Products may be manufactured using new materials or new and 
used materials equivalent to new in performance and reliability. HP may 
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repair or replace HP Hardware Products (a) with new or previously used 
products or parts equivalent to new in performance and reliability or (b) with 
equivalent products to an original product that has been discontinued. 
Replacement parts are warranted to be free from defects in material or 
workmanship for ninety (90) days or, for the remainder of the Limited 
Warranty Period of the HP Hardware Product they are replacing or in which 
they are installed, whichever is longer.

During the Limited Warranty Period, HP will, at its discretion, repair or 
replace any defective component. All component parts or hardware products 
removed under this Limited Warranty become the property of HP. In the 
unlikely event that your HP Hardware Product has recurring failures, HP, at its 
sole discretion, may elect to provide you with (a) a replacement unit of HP’s 
choosing that is the same or equivalent to your HP Hardware Product in 
performance or (b) to give you a refund of your purchase price or lease 
payments (less interest) instead of a replacement. This is your exclusive 
remedy for defective products.

Exclusions

HP does not warrant that the operation of this product will be uninterrupted or 
error-free. HP is not responsible for damage that occurs as a result of your 
failure to follow the instructions intended for the HP Hardware Product.

This Limited Warranty does not apply to expendable or consumable parts 
and does not extend to any product from which the serial number has been 
removed or that has been damaged or rendered defective (a) as a result of 
accident, misuse, abuse, contamination, improper or inadequate 
maintenance or calibration, or other external causes; (b) by operation outside 
the usage parameters stated in the user documentation that shipped with the 
product (c) by software, interfacing, parts, or supplies not supplied by HP; (d) 
by improper site preparation or maintenance; (e) by virus infection; (f) from 
loss or damage in transit; (g) by modification or service by anyone other than 
(i) HP, (ii) an HP authorized service provider, or (iii) your own installation of 
end-user-replaceable HP or HP-approved parts if available for your product in 
the servicing country/region.

YOU SHOULD MAKE PERIODIC BACKUP COPIES OF THE DATA 
STORED ON YOUR HARD DRIVE OR OTHER STORAGE DEVICES 
AS A PRECAUTION AGAINST POSSIBLE FAILURES, ALTERATION, 
OR LOSS OF THE DATA. BEFORE RETURNING ANY UNIT FOR 
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SERVICE, BE SURE TO BACK UP DATA AND REMOVE ANY 
CONFIDENTIAL, PROPRIETARY, OR PERSONAL INFORMATION. 
HP IS NOT RESPONSIBLE FOR DAMAGE TO OR LOSS OF ANY 
PROGRAMS, DATA, OR REMOVABLE STORAGE MEDIA. HP IS 
NOT RESPONSIBLE FOR THE RESTORATION OR REINSTALLATION 
OF ANY PROGRAMS OR DATA OTHER THAN SOFTWARE 
INSTALLED BY HP WHEN THE PRODUCT IS MANUFACTURED. 
UNITS SENT IN FOR SERVICE MAY HAVE THE DATA ERASED 
FROM THE HARD DRIVE AND THE PROGRAMS RESTORED TO 
THEIR ORIGINAL STATE.

Exclusive Remedy

TO THE EXTENT ALLOWED BY APPLICABLE LOCAL LAW, THESE TERMS 
AND CONDITIONS CONSTITUTE THE COMPLETE AND EXCLUSIVE 
WARRANTY AGREEMENT BETWEEN YOU AND HP REGARDING THE HP 
HARDWARE PRODUCT YOU HAVE PURCHASED OR LEASED. THESE TERMS 
AND CONDITIONS SUPERSEDE ANY PRIOR AGREEMENTS OR 
REPRESENTATIONS — INCLUDING REPRESENTATIONS MADE IN HP SALES 
LITERATURE OR ADVICE GIVEN TO YOU BY HP OR AN AGENT OR 
EMPLOYEE OF HP — THAT MAY HAVE BEEN MADE IN CONNECTION 
WITH YOUR PURCHASE OR LEASE OF THE HP HARDWARE PRODUCT. No 
change to the conditions of this Limited Warranty is valid unless it is made in 
writing and signed by an authorized representative of HP.

Limitation of Liability

IF YOUR HP HARDWARE PRODUCT FAILS TO WORK AS WARRANTED 
ABOVE, HP’S MAXIMUM LIABILITY UNDER THIS LIMITED WARRANTY IS 
EXPRESSLY LIMITED TO THE LESSER OF THE PRICE YOU HAVE PAID FOR 
THE PRODUCT OR THE COST OF REPAIR OR REPLACEMENT OF ANY 
HARDWARE COMPONENTS THAT MALFUNCTION IN CONDITIONS OF 
NORMAL USE.

EXCEPT AS INDICATED ABOVE, IN NO EVENT WILL HP BE LIABLE FOR 
ANY DAMAGES CAUSED BY THE PRODUCT OR THE FAILURE OF THE 
PRODUCT TO PERFORM, INCLUDING ANY LOST PROFITS OR SAVINGS OR 
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES. HP IS NOT 
LIABLE FOR ANY CLAIM MADE BY A THIRD PARTY OR MADE BY YOU FOR 
A THIRD PARTY.
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THIS LIMITATION OF LIABILITY APPLIES WHETHER DAMAGES ARE 
SOUGHT, OR A CLAIM MADE, UNDER THIS LIMITED WARRANTY OR AS A 
TORT CLAIM (INCLUDING NEGLIGENCE AND STRICT PRODUCT LIABILITY), 
A CONTRACT CLAIM, OR ANY OTHER CLAIM. THIS LIMITATION OF 
LIABILITY CANNOT BE WAIVED OR AMENDED BY ANY PERSON. THIS 
LIMITATION OF LIABILITY WILL BE EFFECTIVE EVEN IF YOU HAVE ADVISED 
HP OR AN AUTHORIZED REPRESENTATIVE OF HP OF THE POSSIBILITY OF 
ANY SUCH DAMAGES. THIS LIMITATION OF LIABILITY, HOWEVER, WILL 
NOT APPLY TO CLAIMS FOR PERSONAL INJURY.

THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY 
ALSO HAVE OTHER RIGHTS THAT MAY VARY FROM STATE TO STATE OR 
FROM COUNTRY/REGION TO COUNTRY/REGION. YOU ARE ADVISED 
TO CONSULT APPLICABLE STATE OR COUNTRY/REGION LAWS FOR A 
FULL DETERMINATION OF YOUR RIGHTS.

Limited Warranty Period

The Limited Warranty Period for an HP Hardware Product is a specified, fixed 
period commencing on the date of purchase. The date on your sales receipt is 
the date of purchase unless HP or your reseller informs you otherwise in 
writing.

Types of Warranty Service

To enable HP to provide the best possible support and service during the 
Limited Warranty Period, you may be directed by HP to verify configurations, 
load most recent firmware, install software patches, run HP diagnostics tests, 
or use HP remote support solutions where applicable.

HP strongly encourages you to accept the use of or to employ available 
support technologies provided by HP. If you choose not to deploy available 
remote support capabilities, you may incur additional costs due to increased 
support resource requirements. Listed below are the types of warranty support 
service that may be applicable to the HP Hardware Product you have 
purchased.

Customer Self Repair Warranty Service

In countries/regions where it is available, your HP Limited Warranty may 
include a customer self repair warranty service. If applicable, HP will 
determine in its sole discretion that customer self repair is the appropriate 
method of warranty service. If so, HP will ship approved replacement parts 
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directly to you to fulfill your HP Hardware Product warranty service. This will 
save considerable repair time. After you contact the HP Technical Support 
Center and the fault diagnosis identifies that the problem can be fixed using 
one of these parts, a replaceable part can be sent directly to you. Once the 
part arrives, replace the defective part pursuant to the provided instructions 
and documentation. If further assistance is required, call the HP Technical 
Support Center, and a technician will assist you over the phone. In cases 
where the replacement part must be returned to HP, you must ship the 
defective part back to HP within a defined period of time, normally thirty (30) 
days. The defective part must be returned with the associated documentation 
in the provided shipping material. Failure to return the defective product may 
result in HP billing you for the replacement.

With a customer self repair, HP will pay all shipping and part return costs 
and determine the courier/carrier to be used. If customer self repair applies 
to you, please refer to your specific HP Hardware Product announcement. You 
can also obtain information on this warranty service on the HP Web site at:

http://www.hp.com/support

Pickup and Return Warranty Service

Your HP Limited Warranty may include a pickup and return warranty service. 
Under the terms of pickup and return service, HP will pick up the defective unit 
from your location, repair it, and return it back to your location. HP will incur 
all repair, logistics, and insurance costs in this process.

Carry-in Warranty Service

Under the terms of carry-in service, you will be required to deliver your HP 
Hardware Product to an authorized service location for warranty repair. You 
must prepay any shipping charges, taxes, or duties associated with 
transportation of the product to and from the service location. In addition, you 
are responsible for insuring any product shipped or returned to an authorized 
service location and assume risk of loss during shipping.

Service Upgrades

HP has a range of additional support and service coverage for your product 
that can be purchased locally. However, some support and related products 
may not be available in all countries/regions. For information on availability 
of service upgrades and the cost for these service upgrades, refer to the HP 
Web site at:
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http://www.hp.com/support

Options Limited Warranty, Software and Digital Content

Your Options Limited Warranty is a one (1) year (HP Options Limited 
Warranty Period) parts replacement warranty on any HP branded or 
Compaq-branded options (HP Options). If your HP Options are installed in 
an HP Hardware Product, HP may provide warranty service either for the HP 
Options Limited Warranty Period or the remaining Limited Warranty Period of 
the HP Hardware Product in which the HP Options are being installed, 
whichever period is the longer but not to exceed three (3) years from the date 
you purchased the HP Options. The HP Options Limited Warranty Period 
starts on your date of purchase. Your dated sales or delivery receipt, showing 
the date of purchase, is your start date. Non-HP options are provided “AS IS”. 
Non-HP manufacturers and suppliers may provide warranties directly to you. 
EXCEPT AS PROVIDED IN ANY SOFTWARE END-USER LICENSE OR 
PROGRAM LICENSE AGREEMENT, OR IF OTHERWISE REQUIRED BY 
LOCAL LAW, SOFTWARE AND THIRD PARTY DIGITAL CONTENT, 
INCLUDING THE OPERATING SYSTEM OR ANY SOFTWARE OR THIRD 
PARTY DIGITAL CONTENT PREINSTALLED BY HP ARE PROVIDED “AS IS”.  
EXCEPT AS SPECIFICALLY PROVIDED IN THIS LIMITED WARRANTY, IN NO 
EVENT WILL HP BE LIABLE FOR ANY DAMAGES CAUSED BY OR ARISING 
FROM ANY THIRD PARTY DIGITAL CONTENT PREINSTALLED ON YOUR HP 
HARDWARE PRODUCT.
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14 Feedback about this Guide
If you find an error in this guide or just have a suggestion for it, send e-mail to 
manuals@hp.com. The information you send is used only to help us develop 
future revisions of this manual. You will not get a response to your e-mail.

If you require customer support instead, see the HP Media Vault Support 
Guide or go to the website www.hp.com/support.
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Glossary
This glossary defines terms that are used in the HP Media Vault. 

A

all-in-one-gateway A device that provides multiple network features 
such as a router, modem, local area network (LAN) switch, firewall, and/or a 
wireless access point. Also see Local area network (LAN).

anti-virus software Software that checks a hard drive for viruses 
(harmful computer code) that may infect a computer.

B

browser window A browser window is used to display web pages 
either on a web site or stored locally such as the HP Media Vault User's 
Guide.

C

client computers A client computer is a personal computer (PC) that 
accesses the HP Media Vault by the home network. This term also applies to 
computers using remote access to the server. Also known as the user’s 
computer.

Common Internet File System (CIFS) A protocol for how a computer 
requests files from other computers on the network. This is the public version 
of the Server Message Block Protocol by IBM and modified by Microsoft. Also 
see protocol.

D

Digital Living Network Alliance (DLNA) An alliance of leading 
companies in consumer electronics. Its purpose is to create industry standards 
that will allow products from all companies to be compatible with each other 
and to enable a network of electronic devices in the home.

Digital Media Adapter (DMA), Digital Media Receiver (DMR), 
Digital Media Player (DMP) A consumer electronic device that 
communicates with the HP Media Vault and brings digital media streams—
such as photos, music, or video—to your entertainment center.
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digital rights management Technology built into digital media, such 
as music and movies, that allows companies in charge of their copyrights to 
decide how and where media can be used.

domain name A unique name combined with a top level domain (TLD), 
such as .com or .org, also called a "domain extension," makes up the Internet 
domain name.  For example, hp.com is the Internet domain name for Hewlett-
Packard.

Domain Name System (DNS) A server that associates network names 
with IP addresses. Also see IP address.

domain extension A domain extension is an optional part of a network 
name used to logically divide a large network into smaller networks.

drive partition A logical division of a hard disk that create the 
appearance of having separate hard drives for file management, multiple 
users, or other purposes.

Dynamic Host Configuration Protocol (DHCP) The protocol used to 
assign IP addresses to network devices, such as computers. DHCP 
automatically assigns IP addresses to network devices; the assigned address 
can change over time. Also see IP address, protocol, and static IP address.

Dynamic IP address A temporary numeric identification assigned to a 
node in a TCP/IP network.  When computers and devices in the network are 
turned on, they are assigned an IP address by a DHCP server. Internet service 
providers typically assign dynamic IP addresses to the Internet connections of 
their residential and small business customers. Consequently, the IP address to 
the outside world in a cable or DSL modem may change every month, every 
day, or even every hour.

E

Ethernet The standard local area network (LAN) access method for 
connecting devices to a company or home network as well as to a cable 
modem or DSL modem for Internet access.

Ethernet Switch A networking device that connects multiple computers 
within a Local Area Network (LAN). Switches are similar to hubs, but are 
more intelligent. Unlike hubs, switches are capable of inspecting data packets 
as they are received, determining the source and destination computer of that 
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packet, and forwarding it appropriately. By delivering each message only to 
the computer it was intended for, a switch conserves network bandwidth and 
generally offers better performance than a hub. Also called a network switch.

Expansion Bay A slot for adding hard drive storage space to your HP 
Media Vault.

ext3 A computer file system used in the Linux operating system. HP Media 
Vault uses the ext3 file system.

F

FAT32 The 32-bit version of the "File Allocation Table" file system 
developed by Microsoft, common to older versions of the Windows operating 
systems. Also see NTFS (New Technology File System).

file system A way for files to be organized and stored in a computer. 
Some examples of file systems are FAT32, and NTFS (New Technology File 
System).

files and settings transfer wizard A feature in the Windows XP. The 
Files and Settings Transfer Wizard can transfer files, folders, and settings for 
Internet Explorer and Outlook Express in addition to desktop and display 
settings, dial-up connections, and other types of settings to a file on your 
server. On the new computer, you access this file stored on your server and 
transfer the settings and files to your new computer. 

firewall The primary method for securing computers from intruders by 
allowing or blocking traffic into and out of a private network or the user's 
computer.

full access Users have access to all shared folders and drives on a 
network.

G

gateway server A network device that connects one network to another 
network. 

Gigabytes (GB) Equal to 1,000 Megabytes.

H

HTTP Access Allows you to access folders and files on your server in a 
browser window.
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HTTPS A secure HTTP connection. HTTP (HyperText Transfer Protocol) is the 
format used to transfer and send web page information across networks, on 
the Internet, and in help systems. HTTPS is an HTTP connection over encrypted 
Secure Sockets Layer (SSL) transport mechanism. Also see protocol.

HyperText Transfer Protocol (HTTP) The format used to transfer and 
send web page information across networks, on the internet, and in help 
systems. Also see protocol.

I

IP address An IP (Internet Protocol) address is a number that uniquely 
identifies devices, such as computers, on a network.

J

No terms begin with the letter J.

K

No terms begin with the letter K.

L

Linux An operating system based on UNIX.

Local area network (LAN) A small number of computers that are 
connected together in a small area, usually in the same building.

M

map Assigning a drive letter to the connection on a computer to access a 
shared folder on the server.

Mbps Megabits per second. 

Media Access Control (MAC) Address A unique number assigned 
by the manufacturer to all devices, such as computers, that can connect to a 
network. Also known as a physical address. 

media streaming Media streaming sends media—music, photos and 
video files—from the server to other devices that can play the media. The HP 
Media Vault includes functionality that allows media to stream to a Digital 
Media Adapter (DMA). Also see Digital Media Adapter (DMA), Digital 
Media Receiver (DMR), Digital Media Player (DMP).
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mirror, mirrored The automatic copying of data on two separate 
physical disks that creates two separate copies of the same material. If one 
disk fails, a copy of the material will be available on the other disk.

N

NAT (Network Address Translation)  Broadband routers use NAT 
technology to allow network components to share Internet access over a 
single IP address. Additionally, NAT acts like a firewall because the 
computers and other devices—including the HP Media Vault—on the network 
are given IP address that are non-routable (non-internet addresses). This 
masks the real IP addresses of your network components and keeps them 
from being seen outside the home. Also see IP address.

network address A numeric value that uniquely identifies a device on a 
network.

network computer A computer that is connected to other computers, 
creating a network.

no access A setting that does not allow a user to access files and folders 
on the shared network. 

non-mirrored A non-mirrored share is stored on a single hard drive. The 
HP Media Vault does not automatically maintain a copy of these files on a 
second hard drive.

NTFS (New Technology File System) Current standard file system for 
Windows. NTFS replaced Microsoft's previous FAT32 file system, and 
improves performance, reliability, disk space, and security. Also see FAT32.

NTP server NTP stands for Network Time Protocol, which allows the 
server to update its internal date and time automatically. 

0

No terms begin with the letter O.

 P

partition A logical division of a physical hard disk. A partition divides a 
physical disk into separate units, which can be formatted independently.

personal domain A personal domain is a Web address. It allows you to 
access your HP Media Vault and HP Photo Webshare from the Internet. For 
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instance, if you registered MyFamily.hpshare.net for your HP Media Vault, 
you would use this address to connect to your server using remote access. 
Additionally, this address is part of the URL for accessing an album on your 
Photo Webshare.

physical hard disk The actual hard disk (hard drive) located in a device 
that stores files and data.

port 443 A secure port number required for HTTPS (Hypertext Transfer 
Protocol over Secure Socket Layer, or HTTP over SSL). SSL uses a 40-bit key 
size for the encryption algorithm, which is considered an adequate degree of 
encryption for commercial exchange such as banking transactions and retail 
commerce.

port forwarding

privilege level A level assigned by the user that decides what access 
levels are available to other users.

protocol The standard(s) of how computers communicate data with each 
other.

Q

No terms begin with the letter Q.

R

RAID, RAID-1 RAID stands for redundant array of independent disks. 
RAID is a system which uses multiple hard drives to share or replicate data 
among the drives. RAID-1 creates an exact copy or mirror of a set of data on 
two or more disks. Also see mirror, mirrored.

read only A setting that does not allow the user to write data. The user is 
only able to read information. 

redundant Duplication of files on a mirrored system. Also see mirror, 
mirrored.

router A device connected to your computer that joins two or more 
networks. For example, a router connects your local network to the internet. 

Run Box In Windows Vista and Windows XP, press the Windows key + R 
to open the Run box. Alternately, go to the Windows Start menu and select 
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Run. The Run box provides a place to type the location and file name of a 
program you want to run. Click Browse if you are not sure of the program's 
location or file name.

S

Serial ATA (SATA) Serial Advanced Technology Attachment is an 
interface standard that moves information to and from a storage device, such 
as a hard disk.

shared folders A “shared folder” means the same as a “share,” and you 
can use these terms interchangeably: A shared folder is a top-level folder that 
is shared on the network and can store other folders within it. For example, 
the Music shared folder can store other folders (called sub-folders). A 
subfolder might be named for a musician, such as Mark Knopfler. Shared 
folders are sometimes called Shares.

static IP address A number assigned to a device, such as a computer, 
on a network to be its permanent IP address. Also see IP address and 
Dynamic Host Configuration Protocol (DHCP).

sub-folders A folder within a folder or a shared folder.

subnet mask Identifies the portion of the network IP address that can be 
used for subnetworks. Also see IP address.

switch See Ethernet Switch.

system drive The hard drive (or drive partition) containing the operating 
system. 

T

TCP/IP (Transmission Control Protocol/Internet Protocol) A set 
of communications protocols used to transmit data over networks. TCP 
provides for the establishment of connections and exchanges streams of data. 
IP specifies the format of the data. Also see IP Address. TCP/IPv4 is the 
standard protocol in use today. TCP/IPv6 is the standard protocol used by 
Windows Vista. IPv6 main advantage is the increase in number of available 
addresses. Also see IP address.

TCP/IPv4 TCP/IPv4 is the standard TCP/IP protocol in use today.
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terabyte (TB) Refers to a data storage capacity equal to approximately 
1000 gigabytes. 

tray The plastic support for a hard drive in the HP Media Vault. The tray fits 
into the expansion bay. Also see Expansion Bay.

U

Uniform Naming Convention (UNC) UNC identifies shared network 
devices, such as the HP Media Vault Premier. It is a format for specifying the 
location of resources on a local-area network (LAN). It identifies each shared 
resource with a unique address in the following format: \\server-
name\sharedfolder-name. For example, \\HPMediaVault\Documents. 
Also see Local area network (LAN).

UPnP (Universal Plug and Play)  makes home networking simple by 
providing compatibility among networking equipment, software, and 
peripheral devices.  UPnP works with wired and wireless networks, on any 
operating system, to minimize network configuration. UPnP is the protocol 
used by media streaming. Also see protocol.

V

version One copy of a file. A version is created when a file is modified 
and the original copy is kept. When configuring the backup option, the NTI 
Shadow software allows you to save multiple versions of a file. The backup 
versions would be named as follows: mydocument(00).doc (the initial 
version), mydocument(01).doc (the first version), and so on. 

W

web browser An application used to access information on networks, 
on the internet, and in help systems. Common web browsers include Internet 
Explorer, Netscape, Firefox, and Safari. 

Wi-Fi Protected Access (WPA) A technology that allows for increased 
security with wireless networks. 

WINS server WINS (Windows Internet Naming Service) is a server that 
converts NetBIOS network names to IP addresses. Also see IP address.

Wireless Access Point (WAP) A device, such as a wireless router, that 
connects wireless communication devices together to form a wireless network. 
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A WAP often connects to a wired network, and can relay data between 
wireless devices and wired devices. 

Wired Equivalent Privacy (WEP) A protocol that encrypts data on a 
wireless system for security.

X

No terms begin with the letter X.

Y

No terms begin with the letter Y.

Z

No terms begin with the letter Z.
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